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The User’s Guide and Program Help system have been written to provide you with a detailed reference for 
Quick Bid.  At times, you may be directed to Program Help from the User’s Guide. Every effort has been 
made to include as much detail as possible. The Table of Contents and Indexes are valuable resources to 
help you locate information quickly and easily. 
 

User's Guide 
This guide is intended to be a compliment to Quick Bid software.  The sections are presented in an order 
intended to help new users understand the software.  The User Guide provides detailed information about 
Quick Bid tools and commands.  It is designed to assist you in applying program features to your bidding 
projects. Use it as a reference tool along with the Program Help system in your day to day work with Quick 
Bid. 
 
Typographic Conventions 

• Terms of importance, titles to dialog boxes and main menu items will be Capitalized and placed in 
bold for easy recognition when skimming through pages. 

• Menu items you are instructed to choose appear in bold with the greater than (>) symbol separating 
each menu level. For example, if you are instructed to select the Open command in the File menu, 
it appears as File > Open.  

• Helpful hints or information about the topic are provided throughout the document. They 
will be labeled, 'NOTE' (all caps and bold font to catch your attention). 

• Several topics will have more detailed steps outlined in either another section of the user guide, 
or the Help System. They will always be referenced in italics and underlined. For example, “See 
Section 5, Master Menu Lists for more information.” 

 

Program Help 
To locate information in the Program Help about a specific dialog or window, press F1 on your keyboard.  
Information about the screen you are on will appear. 

Anything that is underlined, appears in blue text, or both is a link to additional information. Click on a link 
to access additional information. Sometimes you will have to click on the link again to hide the information 
if you like. These links have been placed throughout the documentation to help you get information when 
and where you need it. 
Related topic links appear on many of the pages. These are included to help you find information that is 
related to the current page you are viewing. If there is only one related topic, you will be directed to that 
topic. If there are two or more related topics, a pop-up box will appear with the topics listed. Click on a 
topic name to go to that topic. 
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NOTE: You will find notes throughout the pages of the Help System. These notes provide additional 
information and important information that will help you in the program. 

At the bottom of the Table of Contents you will find a set of Frequently Asked Questions. These can be 
helpful in guiding you through particular aspects of your project. 

 

Contents Tab 

The Contents tab provides a breakdown of the Help topics.  To view this guide, click the Contents tab.  Each 

topic is represented by a Topic icon . Open a topic by clicking the  icon next to the topic, or double 
click the Topic icon for the same results.   

Below each topic are sub-topics represented by a Sub-topic icon .  Clicking a sub-topic will display its 
contents in the right-side pane.  

Close a topic by clicking the  icon, or double click the Open Topic  icon.   

 

Index Tab 

The Index tab shows a list of indexed topics in alphabetical order. It should be used like a book's index.   

You may type the first few letters of the word or topic you are looking for in the keyword list. This will filter 
the list down to display only topics that start with the letters you entered. If you can't locate a particular 
item, try reducing the number of words in the search. For instance, instead of searching for Creating 
Alternates, try typing in Alternates. This usually helps you to locate information quickly. 

You may also search for a topic by scrolling through the keyword list manually. Double-click on any of the 
keywords and the corresponding topic appears in the right-hand pane. 

 

Search Tab 

You may want to search to locate every occurrence of a word or phrase in the guide. To search for a word, 
click the Search tab and then type the word(s) you are looking for. When the list of topics displays, Double-
click the topic you want to have displayed. The corresponding topic and its contents will display in the right-
hand pane. 

The Search tab works by listing every topic in which the word you typed in appears. Usually, this means you 
will see a large list.  
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Glossary Tab 

The Glossary tab enables you to quickly look up the definition to commonly used terms. The terms are in 
alphabetical order.  When a term is highlighted the definition will appear in the window below.   

Use the scroll bar to search for a term, or click inside the term box, and type the first letters of the word. It 
will jump to the alphabetic location you entered.     

 

Quick Tips 
Using Tool Tips - If you do not understand what a button is for, hover the mouse over it.  A tool tip will 
appear. 

Using the Status Bar - If the program seems like it is processing information but you are unsure of what is 
happening, try looking at the status bar. The status bar is located at the very bottom of the image window. It 
displays information about what Quick Bid is doing internally. It also contains the current date, and if the 
database is set to require a login and password, the user's name will appear as well. 

Using Context Menus - You can right-click on most objects and within most windows to view context 
menus with options available for use. 

Using Expand/Collapse Option - You can expand any folder, condition type or other heading by clicking on 
the [ + ] plus sign next to it. You can collapse any folder or heading by clicking the [ - ] minus sign next to it. 

Using Error Log Tracking - If the program encounters errors to the application a dialog box will be triggered.  
The dialog box will display a message letting you know that an error has occurred.  Report the error to On 
Center Software by clicking the Send Error Log button.  Clicking the Cancel Send button will close the dialog 
box without sending a report to On Center Software.    
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Technical Support 
On Center Software Technical Support is available Monday-Friday, 8am - 5pm, Central Standard Time. 
When requesting support, please send complete details of the question or problem including: 

• Your Full Name 

• Your Company Name  

• Your Client ID 

• Version with build number (Select Help > About Quick Bid) 

• Windows Platform (2000, XP) 

• Complete description of the problem  

• Steps used to recreate the problem 

On Center Software support and advisors are available to help answer your questions through a variety of 
media: 

• Email support@oncenter.com  

• Fill out the support Web Form at www.oncenter.com/support/ 

• Call toll free at 866.689.5687 (Only for those users who have a current support contract.) 

If you have suggestions or comments on how we can improve the product, we would love to hear from you. 
Your feedback is important to us and proper attention will be given to all communication we receive from 
you. 

• Email: requests@oncenter.com, ATTN: Feature Requests 

• Fax: 281.297.9001, ATTN: Feature Requests 
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Quick Bid System Requirements 
The following table lists the minimum requirements for running Quick Bid. The recommended requirements, 
however, will allow your program to run faster and with greater screen resolution. 

 Minimum Recommended 

Windows Operating 
System 

Windows® 2000 (SP4), Windows 
XP (SP2) or Windows Vista 

(program will not run on Windows 
3.X, Windows 95 or Windows 98) 

Windows XP (SP2) 

 

Processor 
32 Bit, Pentium® III, 500 MHz 

(program is not supported on 64 bit) 

32 Bit, Pentium IV, 1 GHz 

(program is not supported on 64 bit) 

Memory 512 MB 1024 MB or more 

Monitor/Resolution Super VGA (800x600) XGA (1024x768) or more 

Free Hard Drive Space 500 MB 1 GB 

 

Installing Quick Bid with Auto-run 
1. Insert the Profit Building Suite CD into your CD drive. 

2. On the Product Startup dialog, choose Install Software. 

3. Click Install Quick Bid.  The Welcome dialog will begin preparing for installation.  

4. On the Welcome dialog, click Next to begin the installation. 

5. Read the Update Notice and click Next. 

6. Read the license agreement, accept the terms of the license by selecting the I Accept button, then 
click Next. 

7. At the Customer Information dialog, enter your User Name, Company Name and Client ID (number 
that came with your Quick Bid package). 
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8. Select users for the application (all users is recommended), and click Next.  

9. At the Choose Destination Location dialog screen, note the Destination Folder, and click Next to 
install Quick Bid to this location. If you want to install Quick Bid to another location, click the 
Browse button, and navigate to the new location.  

10. At the Select Features dialog, make sure that Quick Bid Application is checked and select all the 
other features you want to install. 

a. If you are planning to attend a few Training Sessions, click the Training Databases box. 

b. Click Next. 

11. Choose any of the databases you purchased with your application. The password for each 
purchased database should be included with your shipment. For information on what databases you 
purchased with your program, contact your On Center Software Account Representative. 

12. Once you have selected your databases, click Next.   

13. At the Ready to Install dialog, make sure you have chosen all of the features you want to install and 
click Install.   

14. If you purchased any sample databases, enter the password for each database as prompted. Click 
Next at each prompt for your password.  The Next button will only become active once the correct 
password is installed. 

15. Once the installation is complete, click Finish. 

16. If you have been furnished a hardware security device, install it now.  See Installing Rainbow 
Sentinel Drivers on the following page for instructions.  

 

Installing Quick Bid without Auto-run 
1. Insert the Profit Building Suite CD in the CD drive. 

2. Select Start > Run. 

3. Click Browse and navigate to your CD-ROM drive. 

4. Double-click on Launch.exe. 

5. Click the OK button. 

6. Follow instructions 1-15 from Installing Quick Bid with Auto-run, located on the previous page. 
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Installing Rainbow Sentinel Drivers 
1. Insert the Profit Building Suite CD in the CD drive, and make sure the USB dongle is removed. 

2. Select Install Software. 

3. Select Additional Software & Drivers. 

4. Select Sentinel Drivers.   

NOTE: If you do not have the CD, the drivers can be downloaded via the internet at 
http://downloads.oncenter.com/Drivers/SSD5411-32bit.exe. 

 

Rainbow Sentinel Driver Troubleshooting 
1. Verify your dongle is physically connected to your computer. If it’s not connected, connect it. 

2. Open Quick Bid. 

3. From the File menu, click Check Authorization. 

4. In the License Authorization dialog, your Host ID is listed. If this number is an 8 to 11 digit number, 
go to step 16 below. 

5. If this number is a long character string (ex. 000D000F000E etc.) or blank, the dongle is not properly 
installed making it unrecognizable to your PC. 

6. Close Quick Bid, and unplug your dongle from your PC. 

7. Insert your Quick Bid CD. 

8. Choose Browse CD (It should auto-run the Demo Shield installer). 

9. Open the Rainbow folder. 

10. Inside the Rainbow folder there is a file called SSD5411 32-bit.exe. 

11. Double-click the file to open it. 

12. Follow the instructions for the driver installation. Reboot your computer if prompted. 

13. Once installation is complete and/or once computer is rebooted, plug in your dongle. Windows 
should now attempt to detect the dongle. 

14. Open Quick Bid. 

15. From the File menu, click Check Authorization. 
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16. Your Host ID should now appear as an 8 to11 digit number. If it does, click Reauthorize. Your 
program should be authorized. 

17. If it still is not generating an 8-11 digit number, there is a problem with your computer, operating 
system, or dongle, Contact On Center Software Technical Support at 866.689.5687, or you can 
contact via email at support@oncenter.com. 

NOTE: There is a 30-day trial period on new licenses to allow for On Center Software's 30-day satisfaction 
guarantee. Once this 30-day period has elapsed, your license is updated to permanent status automatically 
via the Internet.  

 

Authorizing Quick Bid 
After installing Quick Bid, insert your dongle. Once the dongle is connected, you should not lose 
authorization as long as you keep the dongle plugged in and maintain a running Internet connection.  If you 
remove the dongle while using the software, you will lose the license and will need to be reauthorized again 
via the Internet.    
An internet connection is also important for the license validation process that occurs every 60 days to 
update your license.  If your computer does not have Internet access or for other authorization issues, call 
On Center Software Technical Support at 866-689-5687. 

NOTE: You will need your Client ID, provided by On Center Software, to authorize Quick Bid. 

1. From the File menu, click Check Authorization. 

2. If you enter an incorrect Client ID, or the field is blank, click  and enter the correct 
Client ID. 

3. Click  to connect to the OCS Server.  

4. Click  to close the License Authorization dialog after you are authorized. 





Section 3 — Toolbars, Menus & Shortcuts 

      13 

Section 3 

Toolbars, Menus & Shortcuts 



Section 3 — Toolbars, Menus & Shortcuts 

14 

Toolbars 
This page lists the two toolbars in Quick Bid. Hover your cursor over a toolbar icon in the open program.  A 
tool tip will provide a brief description of the icon. Tool tips appear on the toolbars below for quick 
reference. 

 

Main Toolbar 

  

 

 

Bid Toolbar 
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Menus 
There are seven Quick Bid menus.  Many of the menu commands also appear in toolbars. 

 

View Menu 

 

See View Menu, in Program  Help, for menu 
option descriptions 

File Menu 

 
See File Menu, in Program Help, for  
menu option descriptions 

Edit Menu 

 
See Edit Menu, in Program Help, for 
menu option descriptions 

 
 
 

 
Tools Menu 

 

See Tools Menu, in Program Help, for menu 
option descriptions 
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Bid Menu 

 

See Bid Menu, in Program Help, for menu 
option descriptions 

 
Help Menu 

 

See Help Menu, in Program Help, for 
menu option descriptions. 
  

Master Menu 

 

See Master Menu, in Program Help, for 
menu option descriptions 
 
NOTE: The items in the Master Menu 
are also referred to as Database tables or 
Master lists. Any changes you make to 
Master lists will affect all future uses of 
that list. Depending on your location in 
Quick Bid, making changes to items at 
the bid level will also allow you to 
change the Master lists. 
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Shortcuts  
Toolbars, Function keys and Combination keys provide quick shortcuts to special features in the program. 

Icon Function Shortcut 

New 
 Creates new bid, condition, markup, etc. depending on 

focus Ctrl + N 

Open 
 

Accesses Open Database dialog to open/close databases Ctrl + O 

Print 
 

Prints a report depending on what tab you are viewing Alt + F, P 

Print Preview 
 Print Previews a report depending on what tab you are 

viewing Alt + F, V 

Cut 
 

Removes selection and copies to clipboard Ctrl + X 

Copy 
 

Copies selection to clipboard Ctrl + C 

Paste 
 

Pastes copied or cut selections from the clipboard Ctrl + V 

Duplicate 
 

Duplicates selected bid, condition, item, etc. Ctrl + D 

Delete 
 

Deletes selected bid, condition, item, etc. Delete key 

Main 
Toolbar 

Tell a Friend 
 Opens a web page allowing you to refer a friend to 

Quick Bid   
Select Active 
Bid Section 

 
Opens the Select Active Bid Sections dialog   

Cover Sheet 
 

Opens the bid Cover Sheet for the selected bid   

Reports 
 

Opens Bid Reports dialog   

Proposals 
 

Opens the Generate Proposal dialog   

Exports 
 

Opens Bid Exports dialog   

Bid    
Toolbar 

eQuote 

 Sends a material quote request to Gypsum Supply Co. 
(only visible if eQuote settings are activated)    
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Access Help File F1 

Edit current cell F2 

Pull up Item Detail F3 

Pull Lookup for current cell F4 

Function Keys 

Cycle Material and Labor F5 

Recalculates Bid Ctrl + Alt + R 

Saves Database as  Ctrl + S 

Cycle to previous condition Ctrl + Page Up  

Cycle to next condition 
Ctrl + Page 
Down  

Inserts new bid, condition, item, etc. depending on focus Insert key 

Accept /Close current window Ctrl + Enter 

Dismisses dialog and/or  reverts data to last known state Escape key 

Shortcuts 

Opens list if current cell has Lookup button Spacebar 
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Tabs 
Quick Bid is designed with nine tabs that focus on different aspects of your bid.  Each tab displays bid 
information for the bid highlighted in the Bid Navigator or selected from the Bids tab.   

 

Under each tab are column headings.  These headings can be easily moved within the header row by 
clicking and dragging.  Each heading will also perform an ascending or descending sort by clicking the up or 
down arrow next to it.  The details of each tab, including information about column headings, are outlined 
in this section. 

 

Bids Tab 

The Bids tab displays a summary for each bid in the current database. To use the features present on the 
remaining tabs, you must fist select a bid from the Bids tab.  

 

• To help you find bids quickly, there are four filter fields located directly below the main tabs: 
Project Name, Primary Contact, Job Type and Estimator. 
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o To filter by Project Name or Primary Contact, type the name in the respective field, and the 

bid list will sort based on your entry.  To turn the filter off, click the delete button  next 
to that field.  
NOTE: The Project Name filter will remain persistent between sessions.   

o To filter by Job Type or Estimator, click the arrow in the field.  Scroll to your selection and 
click on it. The bid list will sort based on your selection.  

• Each column can be sorted by clicking the arrow in the column header. 

• Right-clicking on a bid in the Bids tab brings up a menu that allows you to perform actions related 
to that bid. 

 

NOTE: Double click on a bid; or select it, and press Enter from your keyboard to get to the Conditions tab 
for that bid.  
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Conditions Tab 

The Conditions tab displays a summary for each condition in the current bid.    

 

• Use Section, Area or Type filter fields, located directly below the main tab, to sort. 

o Click the arrow in the filter field you want to sort by. Scroll to your selection, and click on 
it. The conditions list will sort based on your selection. 

• Each column can be sorted by clicking the arrow in the column header. 

• To group the conditions list by Condition Type, right-click anywhere in the Conditions tab window. 
Select Group by Type from the menu that appears.  

 

• To open the Condition Detail for a particular condition, double-click on the condition, select a 
condition, and press Enter on you keyboard.  You can also right-click on the condition, and select 
Show Condition Detail. 

• To create a new condition, right-click anywhere in the window, and select New Condition.  You 
can also hit Insert on your keyboard, or select File > New > Condition from the main menu. 

NOTE:  See Section 9, Conditions for detailed information on creating conditions. 



Section 4 — Tabs, Dialogs & Measurements 

      23 

Subs Tab 

The Subs tab allows you to enter and keep track of subcontractor bids.   

 

1. Right-click anywhere in the Subs tab window, and select New Subs Bid from the menu, or  

click the Lookup icon  in the Subcontractor column if there are no subs assigned yet, or  

Hit the Insert key on your keyboard. 

2. Click on a sub from the Contacts (Master) dialog and click . You will return to the Subs 
tab window. See Section 5, Master Menu Contacts for information on how to add a sub to the 
database. 

3. Once you have entered the Subcontractor, enter a Section if not already entered, or click the 

Lookup icon  to select from a list.   

NOTE: Section numbers are based on The Construction Specifications Institute MasterFormat™ 
2004 edition. 

4. Enter the Bid Amount, if known, or use the Subcontractor Bid Worksheet to calculate the amount. 

a. Click the spreadsheet icon  to go to the Subcontractor Bid Worksheet.  

b. Click  to add a new line.   

c. Enter all of your numbers, the total for all numbers you entered will appear in the lower 
right section of the dialog. 

NOTE: Using the Subcontractor Bid Worksheet will only fill in the Bid Amount field. Other 
entries must be entered manually. 

5. Enter an Escalation percentage if applicable, which will escalate the subcontractor bid total 
anywhere the total appears, such as in bid totals, bid reports, etc.  See Section 10, Bid Areas and 
Typical Areas for more information. 
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6. Either check the Multi box to break the subcontractor's bid across multiple areas, or enter an Area to 
assign a single area.  

• If the Multi box is checked, the Subs Multi-Area dialog will appear. Enter the dollar value 
you want assigned to each area. 

• Leave the Multi Area box empty, and use the Lookup icon , in the Area column, to 
select from a list.  This will assign the full amount to one area. 

7. Check MBE or WBE for minority or woman owned businesses. 

8. Enter a Cost Code, or click the Lookup icon  to select from a list. 

9. Enter any Notes you may want to include.  

10. Place a check in the Check box located to the left of the Section field. Checking here will accept the 
subcontractor bid into the bid total. 

11. To resort the information in any a column, click the arrow in the column header. 

NOTE: Right-clicking anywhere in the Subs tab brings up a menu that allows you to perform other actions. 
The bottom four selections in this menu allow you to customize the layout of the Subs tab.  
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Equip Tab 

The Equip tab displays a summary for each piece of equipment or equipment assembly in the current bid. 

 

1. Right-click anywhere in the Equip tab window, and select New Equip Entry from the menu, or  

Press Insert on your keyboard, or 

Select File > New > Equipment from Main menu 

2. Enter a description of the equipment in the Equipment field, or right-click anywhere in the Equip tab 
window and select Insert Equipment Assembly from the menu. See Section 9, Equipment 
Assemblies for information on how to create and insert equipment assemblies into your bid. 

3. Enter a Section, or click the Lookup icon  to select from a list. 

4. Enter a Qty (quantity). 

5. Enter a Unit, or click the Lookup icon  to select from a list. 

12. Either check the Multi box to break equipment quantities across multiple areas, or uncheck and 
enter an Area to assign a single area.  

• If the Multi box is checked, the Equip Multi-Area dialog will appear. Enter the quantity you 
want assigned to each area. 

• Leave the Multi Area box empty, and use the Lookup icon , in the Area column, to 
select from a list.  This will assign the full quantity to one area. 

6. Enter the Equip Rate. The Equip Total field will auto-populate by multiplying the Qty and Equip Rate 
fields. 

7. Enter a Cost Code, or click the Lookup icon  to select from a list. 

8. Enter the Lab. Rate (labor rate).  The Lab. Total (labor total) field will auto populate by multiplying 
the Qty and Lab. Rate fields. 

9. Enter a Lab. Cost Code (labor cost code), or click the Lookup icon  to select from a list. 

10. Enter a Payroll Class, or click the Lookup icon  to select from a list. 
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11. Enter a Wage Type, or click the arrow to select from a list. If no wage types are entered, type in a 
description and you will be prompted to add it. 

12. Each column can be resorted by clicking the arrow in the column header. 

NOTE: Right-clicking anywhere in the Equip tab brings up a menu that allows you to perform actions related 
to the equipment in the current bid. 

 
Other Tab 

The Other tab allows you to include additional costs, either direct or indirect, that are not covered 
elsewhere in the bid. You can enter any miscellaneous labor or material expense. You can also save a group 
of other costs as an Other Assembly, or create general conditions that are specific to the current job only. 

 

1. Right-click anywhere in the Other tab window, and select New Other Entry from the menu, or  

Press Insert on your keyboard, or 

Select File > New > Other from the Main menu. 

2. Enter a description in the Other field, or right-click anywhere in the Other tab window and select 
Insert Other Assembly from the menu. See Section 9, Other Assemblies for information on how to 
create and insert assemblies into your bid. 

3. Once you have entered the Other item, enter a Section or click the Lookup icon  to select from 
a list. 

4. Enter a Qty (quantity). 

5. Enter a Unit, or click the Lookup icon  to select from a list. 

13. Either check the Multi box to break other quantities across multiple areas, or uncheck and enter an 
Area to assign a single area.  

• If the Multi box is checked, the Other Multi-Area dialog will appear. Enter the quantity you 
want assigned to each area. 

• Leave the Multi Area box empty, and use the Lookup icon , in the Area column, to 
select from a list.  This will assign the full quantity to one area. 
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6. Enter the Other Rate.  The Other Total field will auto populate by multiplying the Qty and Other 
Rate fields. 

7. Enter a Cost Code, or click the Lookup icon  to select from a list. 

8. Enter the Lab. Rate (labor rate). The Lab. Total (labor total) field will auto populate by multiplying 
the Qty and Lab. Rate fields. 

9. Enter a Lab. Cost Code (labor cost code), or click the Lookup icon  to select from a list. 

10. Enter a Payroll Class, or click the Lookup icon  to select from a list. 

11. Enter a Wage Type, or click the arrow to select from a list. If no wage types are entered, type in a 
description and you will be prompted to add it. 

12. Each column can be resorted by clicking the arrow in the column header. 

 

Markups Tab 

The Markups tab displays a list of all bid sections used in the current bid. Each section has its own markups 
and other attributes that affect its total. 
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Adjustments can be made on the Markup Detail dialog to Stock, Cleanup, Supervision, Escalation, Tax, Per 
Diem, Overhead and Profit.   

1. Highlight the section, right-click and select Show Markup Detail, or  

Highlight the section, and press Enter on your keyboard, or 

Double click the section. 

2. The Markup Detail dialog for that section will appear, and you can adjust your markups. 

NOTE: See Section 9, Markups for in-depth information about adding and modifying Markup 
Details. 

3. Add additional sections by pressing Insert on your keyboard. See Section 5, Master Menu 
Divisions/Sections for information on adding sections. 

 

Materials Tab 

The Materials tab displays a list of all materials used in the current bid. 

 

• Use the Section, Area, Cost Code and Type filter fields, located directly below the main tab, to help 
sort. 

• Check in the View conditions in use box to display a list of all conditions in which the selected item 
appears.  The list will appear at the bottom of your screen. 

• Clicking a column header will sort by that items according to that heading. 
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• Adjust material item details directly in the material list via the function menu.  Access the function 
menu by right-clicking in any cell. The menu will appear. 

 

o Modify Item will take you to the Item Detail to make changes. 

o Update Unit Cost allows you to change the unit cost by a percentage for all filtered items. 

o The Round all to Nearest Container command will round up all the materials on this list to 
the closest whole container for each by adjusting the waste factor.   

NOTE:  This can be helpful in accurately estimating the true cost of materials in a job. You 
may filter the list to specific areas and round up quantities on each floor, phase, unit, etc. 
Rounding up or down will change your selling price because the quantities and subsequent 
cost are being modified. If you are locked into a contract price, you can still round up 
quantities before you buyout the job. However, your selling price will be affected by the 
changes, so once the changes are made, return to the Markups tab and reset your selling 
price to the contract value. If you are rounding up, your profit percentage will be reduced 
by the added cost from rounding up. 

NOTE:  This command cannot be undone.  

o Show Description will either enable or hide the Description column in the material list. 

o Show Decimal Places function is only available by right-clicking in a cell with a number. 

 

Labor Tab 

The Labor tab summarizes labor charged to each Cost Code at a specific production rate. It displays a list of 
all Cost Codes used in the current bid.  These Cost Codes are account codes that track line items of labor 
generated from all tabs.   



Section 4 — Tabs, Dialogs & Measurements 

30 

 

• Use the Section, Area, Cost Code and Condition Type filter fields located directly below the main 
tab to help sort.   

• Each column can be sorted by clicking the column header. 

• Place a check in the View conditions in use box to display a list of all conditions in which the 
selected cost code appears. 

• Use the  button to modify time, days and cost for each item. 

• Adjust Cost Code, Qty/Day, Cost and Wage Type for each labor detail by typing changes directly in 
the cell.   

• Adjust labor details for either entire list or filtered list through the function menu.  Right-click in any 
cell to display the function. 

 

NOTE: See Tabs, Labor Tab, in the Program Help system for a detailed explanation about rounding and 
adjusting labor production. 

WARNING: Changes made on the Labor tab are immediate and permanent.  
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Payroll Tab 

The Payroll tab displays a list of all Payroll Classes used or created for the current bid. The information 
contained on the Payroll tab, and any changes made on the Payroll tab are specific to the current bid only. 

 

• Use the Section, Area, Cost Code and Condition Type filter fields, located directly below the main 
tab to help sort.  

• Place a check in the View conditions in use box to display a list of all conditions in which the 
selected item appears.  It will be displayed at the bottom of your screen. 

• Adjust Payroll Class details by double-clicking on an item or selecting an item and pressing Enter on 
your keyboard.  The Payroll Class Detail dialog will appear, and you can make adjustments.   

• To access the function menu, right-click in any cell. The menu will appear. 

 

• Change Base/hr to Base/day, Burden $ to Burden %, Wage/hr to Wage/day, Total Hours to Total 
Days. Right click within that particular column and select the appropriate change.   

NOTE: The actual menu does not appear as shown.  The last four selections are specific to their 
respective column headers. For example, the Burden $ function will appear only if you right-click in 
the Burden % column. 
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Dialog Boxes 
Dialog boxes come in many forms in Quick Bid. Every piece of information you enter in Quick Bid will be 
entered in a dialog box. The Condition Detail (shown below) is an example of a dialog box.  

 

Many dialog boxes contain list fields.  These fields pull from the lists you created in the Master menus.  They 
are usually accompanied by type ahead, drop down, lookup and add in features.   

 
• Type ahead - Once you type the first letters the program will enter a corresponding alpha or 

numeric entry from the list.  

• Drop down - Clicking on the  button, will reveal the list for that field.  You can then select an 
item from the list by highlighting it and clicking. 

• Lookup - Clicking the  icon will display the appropriate Master menu list dialog for that field. 

• Add in - Typing in something new will trigger a dialog asking if you would like to at it to the list.  
Clicking Yes will open the list dialog.  
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Units of Measurement (UOM) 
Quick Bid can accommodate both Imperial and Système International (SI)-metric in the United States- 
UOMs. When you create a database, you choose which system of measurement to use.  All UOM boxes in 
the database will be based on the system of measurement you choose. 

The UOM is the base measurement used to define quantities throughout the database tables including Bid 
Reports.  The UOM also controls the options available at the Calculation, Sizing and Pricing tabs, and 
dictates the data required for the calculations.  The UOM is a tag that always accompanies a quantity.  If you 
are building a material record, the UOM will generally correspond with the UOM quoted by your supplier.  

An Item record can only hold a single UOM, therefore once you set the UOM to define material quantities, 
all labor values will carry the same UOM.  For example, you may price wall covering by the LY, so the 
UOM would be set to LY. If labor is attached to the same record, you must price the labor by LY.  If you 
prefer labor priced by the SF rather than LY, you must build a separate Labor only record using SF as the 
UOM. 

Imperial UOMs Metric/Système International (SI) UOMs 

EA Each EA Each 

IN Inches mm Millimeters 

LF Linear-Feet mm2 Square-Millimeters 

LY Linear-Yards m Meters 

IN2 Square-Inches m2 Square-Meters 

SF Square-Feet mm3 Cubic-Millimeters 

SY Square-Yards m3 Cubic-Meters 

SQ Square (Roofing)   

CF Cubic-Feet   

CY Cubic-Yards   

NOTE:  When entering in height, the last two digits that you type will always calculate inches and will 
always convert to feet. For example:  824 will be 10' 0", 10 will be 10" and 1010 will be 10' 10".  If using 
the metric system, all measurements are entered and stored as millimeters.    
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Section 5 

Master Menu Lists 
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Master Menu Lists 
The Master menu allows you to access and configure lists that are stored on the database.  Anything 
modified at the master / database level will affect all future bids.  Master list dialogs are labeled (Master) to 
indicate that they are database level lists.  It is important to pay close attention to any modifications you 
make in these dialogs.  

Changing an existing record at the Master level will affect all future jobs, but will never affect a job 
previously entered. You may delete an existing record from the Master Items List even if that record has been 
used in a job. However, you cannot delete a record if it is currently in use in an assembly or if it is used as 
part of a chain or mixture. 

NOTE:  Changes you make at the Master level are immediate and permanent.  Proceed with caution when 
deleting from one of the Master menu lists.  It will delete the information from the database.  This deletion 
cannot be undone.  
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Master Menu Contacts 

Before you begin working in a database, it is helpful to input all of the companies with whom you do 
business. Contacts can be your company, subcontractors, architects, engineers, clients, etc. Depending on 
your business practices, you can enter company information, contacts for those companies, company AEC 
(Architectural, Engineering, Construction) information and notes about a company. 

NOTE: It is important that you set up your own company in the contacts list.  You will most likely be using it 
as the default bidding company. The default bidding company appears on the Cover Sheet of each new bid 
and on all bid reports. 

1. From the Master menu, click Contacts. The Contacts (Master) dialog appears. 

 

2. Click . The Company Detail (Master) dialog appears. 
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3. Enter a contact type in the Type field or click the Lookup icon  to select from a list. 

4. Enter in the contact's information in the fields provided. 

5. Place a check in the box next to Use on Cover Sheet as a Bidding Company if you want this to be 
the default bidding company.   

6. To keep a record of important individuals who work for each of your company contacts, click the 

Contacts tab.  Click . The Contact Detail (Master) dialog appears.   

 

Enter the contact's information and click  to return to the Company Detail (Master) 
dialog. 

NOTE: You can enter multiple contacts for a single company.  

7. To include more detailed information about a company. Click the AEC Info tab, and input 
information you want included.  

 

8. To document additional notes about the company, click the Notes tab.  Type your notes directly 
into the space provided.  

9. After all information is entered, click  to return to the Contacts (Master) dialog. 
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Master Menu Contact Types 
Creating a list of Contact Types allows you to group contacts that share a commonality that would be 
beneficial for a future sort. 

1. To create a new contact type, from the Master menu, click Contact Types. The Contact Types 
(Master) dialog appears. 

 

2. Click . A blank line will appear. 

3. Enter the name of the new Contact Type and click . 

NOTE: New Contact Types can also be added on the bid Cover Sheet. Once you have entered a Company 
in the Project Contacts field, click in the Type field. The Contact Types List (Master) dialog will appear. 
When you create a new contact type here, it is saved at the Database or Master level and can be used in 
other bids. 

 

Master Menu Items 

The Items List (Master) contains all of the items you need for your bid.  An Item is anything related to labor 
or material in a particular database. The Master Items List consists of all the items cost codes, labor codes 
and material codes needed for a job.    

The Items List (Master) is for reference only. You can create a new, modify or delete an item by selecting it 
in this list. Creating new items or modifying items is done on the Item Detail (Master) dialog.    
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The Item Detail (Master) dialog is presented in six basic parts: the header which describes the Item and five 
tabs which give you access to Tables that hold default information for cost codes, quantity calculations, 
sizing and pricing information.   

Header Fields 

• Code field allows you to easily identify your item by using an abbreviated description of the item.  
For example, 8" Truss Type can be coded TT08. The abbreviations should be unique for each item 
in the database. 

• Description field allows you to add a detailed description of the item for reference.  
• UOM field allows you to choose how the item will be measured.  Click the drop down arrow for a 

list of measurements. See Section 4, Units of Measurement for more information on the choices 
available. 

General Tab 

• Item Setup - Choose what you are setting up; either material, labor or both.   

• Mat. Cost Code - Assign a material cost code to the item.  Type one in, or use the Lookup button to 
select from the Cost Code List (Master).  This is a required field for items with a material part. 

• Type - Assign an Item Type.  Enter a new Type or use the Lookup button to select from the Items 
Types (Master).  This is an optional field. 

• Manufacturer - Type in a new Manufacturer or use the Lookup button to select from the Material 
Manufacturers (Master).  This is an optional field and only available if setting up a material item. 
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• Suppliers - Assign a supplier by clicking the New button.  Type in or use the Lookup button to pick 
from the Contacts (Master) list. Checking the Show SPID box will display the Supplier ID Code.  By 
default the ID Code is the Item Code. 

• Chained Items - Select items to be chained to this item. Click the New button, and use the Lookup 
button in the Item field to select from the Items List (Master).  See Section 10, Chained Items, for 
more information.  In Size / Style cell you can choose possible size or style for the chained item or it 
will auto-size default to the default selection. QB automatically chooses appropriate size\style 
based on detail height. This cell is enabled only for items with determined size or style. 

Calculation Tab 

The Calculation tab is used to set the parameters for calculating an item's quantity.  It identifies and sets 
aspects of the Item that affect project calculations. 

 
• Calculation Method  

o Use Condition - Determine which condition quantity will be used to calculate the detail 
quantity. Quantity 1 is selected by default. Use the drop down arrow to change the selection. 

o Method to use -  Select a method of calculation 

• Standard Formula - Calculates the item quantity by factoring the condition quantity by 
height, width, depth, OC, layers and waste. 

• Enter Direct Quantity - Drops the item into the condition with a zero quantity and 

allows you to enter the quantity manually.  

• Default to Condition Quantity - Causes the item quantity to be the same as the Condition 
Detail’s quantity.   
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• Quantity * Height - Calculates the item quantity by factoring the condition quantity by 
height, OC, layers and waste.  (Multiplies item quantity by the height.)  

o Waste % - Item quantities calculated by the standard formula or quantity*height may be 
modified by specifying a waste percentage. 

• Formula Descriptions - This area displays the mathematical formulas used to calculate the item 
quantity. 

• Condition Detail Default Entries - These entries are defaults for a condition detail.  

o Section - An entry to assign a CSI section number most commonly associated with this Item. It 
is a mandatory field that holds unique markup information and indirect costs. 

o Lab. Cost Code - An entry to assign a Cost Code that represents labor.  This is a required field 
for items with a labor part. 

o Height - An entry to setup a default height for the Item (Leaving it set to zero will allow the Item 
to use the Condition Detail’s height) 

o Repeat every - An entry to set the recurrence of a count object along a vertical line based on 
height.   

o On Center (OC) - An entry field to store information for the On Centers (OC) of material that 
repeat at fixed intervals. The installation method selected shall determine which default field 
(Height or OC) is available for calculating the material. Continuous Items do not have On 
Centers. 

o Rows/Layers - An entry to choose the default number of rows or layers needed to build this Item 

• Installation Method  

o Horizontal - This method ignores height in the formula when a quantity is calculated. When 
selected, the Condition Detail quantity is divided by the OC default and that result is factored 
by the layers. If the quantity is to result in either a liner or each UOM, then Horizontal should 
be selected 

o Continuous - This method ignores OC when a quantity is calculated.  When Continuous is 
applied, the Condition Detail quantity is multiplied by the height and that result is factored by 
the layers. If the quantity is to result in a square UOM, then Continuous should be selected. 

NOTE: Selecting both Horizontal and Continuous turns off both Height and OC in the formula. 
When applied, the Condition Detail quantity is multiplied by the layers default. If the Item quantity 
is to result in a liner or each value, both Horizontal and Continuous can be selected. 

• On Center Exception Factors - These entries switch the standard formula to the OC exception 
formula. 
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o At 16" OC - The waste applied to a calculated quantity can be controlled by exception factors. 
You may enter different percentages for each OC default setting whereas the Waste % field 
applies the same percentage to all OC settings. The Exception factor is expressed as decimal 
value and if applied, the Exception factor will override the Waste%. This field applies to 16” 
OC values.  This is an optional entry. 

o At 24" OC - You can type in a waste percentage to add to this on-center value.  This is an 
optional entry. 

Sizing Tab 

The Sizing tab is used to convert quantities into usable sizes or combine quantities into standard containers.  

 
• Size Method  

o Sizes - Use this option to setup the most common sizes available for this Item.  Remember, it is 
not necessary to enter every possible size for the item, only the most common sizes.  Special 
sizes may be entered directly at the Condition Detail by clicking the size dropdown menu and 
selecting NEW. 

o Styles - This option allows you to enter a different price for each style name.  Entering a material 
by Style works well for materials that have a single size but come in a variety of grades. For 
example, a door unit that is available in paint grade, stain grade, oak, birch or any other wood. 

o Styles with Size - Use this option to enter a different price for each size/style name.  
o No Sizes - Use this option if size does not pertain to this item.  
o Mixture - This allows you to enter specific material quantities for a combination of materials 

required for a given coverage or yield. It also allows you to combine a group of material items 
into a single line entry in a Condition Detail where labor will apply to the mixture.  For 
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example, our Item Code TF-4 (Tape & Float Level 4) is a mixture of two other material Items: 
Tape-250 and Mud4. These materials are listed below the Yield of 1,000SF. 

• Container - Allows you to choose a description that represents what unit the item is priced by. 

• Mixture Yield - This is a hypothetical value that allows Quick Bid to calculate the quantity of 
materials required in a mixture.  

• Grid Area - Enter the appropriate sizing information for Sizes, Styles and Styles with Sizes.  For 
Mixtures, assign a coverage yield or quantity and Item Code.   

Material Pricing Tab 

 
• Material Price Method 

o UOM - Use this option to price the item every 1, 100 or 1000 units of measure. 

o Style - Use this option to set up a specific price for each style.  Styles must be entered at the 
Sizing tab in order to price style.  

o Piece - Use this option to set up a specific price for each size of this item. 

o Container - Use this option to set a price for the container the item is sold by. 

Labor Pricing Tab  

The Labor Pricing tab is used to set how the program calculates labor in the bid. 
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• Labor Price Method 

o UOM - Use this option to control the labor production units (linear, square, each, etc. ) by the 
UOM selected for the Item record (upper right corner)  

o Style - Use this option to set up production per day, hour and labor cost for each different style 
of this Item 

o Piece - Use this option to set up production per day, hour and labor cost for each different size 
of this Item 

o Container - Use this option to set up production per day, hour and labor cost for each different 
container the Item is priced by 

• Default Wage Type - Choose the default wage type for the pay class if it is different from the Global 
default wage type 

 

Duplicate and Modify an Existing Item 

When adding new material and labor Items to your Master list, you may duplicate an existing record then 
modify it or construct the Item Detail from scratch. To duplicate an Item at the Master Items List, select the 
Item you want to duplicate. 

1. Click the Duplicate button, Right click and select Duplicate Item, or press Ctrl D from the keyboard. 

2. An exact copy of the original will be automatically duplicated into the Items List (Master). Since 
each record must have a unique code, the Item Code will be slightly altered with an underscore 
mark and the number 1 added to the original code (PR becomes PR_1 when duplicated).  

3. Change the Item Code. 
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4. Modify the Description (name) of the item. 

5. Enter a current Price for the new item. 
 

Adding New Items 

Occasionally you will need to add a new material or labor item that is unlike any other existing record.  

1. From the Main menu, select Master > Items.  The Items List (Master) dialog will appear. 

2. Click . A blank new Item Detail (Master) will be displayed. 

3. Fill out the header field and each tab. See Master Menu Items, Item Detail (Master) Dialog, in this 
section, for details about these fields and tabs. 

 

Master Menu Item Types 
The master list of Item Types stores all the types of items you can create.  Item Types are a basic description 
or categorization of an item. 

 

1. To create a new Item Type, from the Master menu, click Item Types. The Item Types (Master) dialog 
appears. 
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2. Click . A blank line will appear. 

3. Enter the name of the new Item Type and click . 

4. To change the Item Type for a particular item, go to the Item Detail for that item and enter the new 

Item Type in the Type field or click the Lookup icon  to select from a list. 

 

Master Menu Manufacturers 

It is not required to include Material Manufacturers in your bids, but including them can help you keep track 
of material pricing better. 

 

1. To add a new Manufacturer, from the Master menu, click Material Manufacturers. The Material 
Manufacturer (Master) dialog appears. 

2. Click . A blank line will appear. 

3. Enter the name of the new Material Manufacturer and click . 
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Master Menu Containers 

Containers refer to the manner in which a piece of material is priced. For instance, a container can be a box, 
bundle, each, etc. The Containers (Master) dialog stores a list of containers you can use in your bids. 

 

1. To add a new Container, from the Master menu, click Containers. The Containers (Master) dialog 
appears. 

2. Click . A blank line will appear. 

3. Enter the name of the new Container and click . 
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Master Menu Divisions/Sections 

Division and Section designations are taken from MasterFormat™ 2004 Edition produced by The 
Construction Specifications Institute (CSI) and Construction Specifications Canada (CSC).  The default listings 
in Quick Bid do not include every Division or Section in the Master Format 2004 Edition.  You may 
customize the list to include only those Divisions and Sections that affect your particular operation.   

 

Adding and deleting Divisions and Sections is done at the Master level.  Sections are assigned to divisions in 
Quick Bid.  To create a new section you must either create it under an existing division or create a new 
division to assign it under.   

 

Creating a New Division 

1. From the Master menu, click Divisions/Sections. The Divisions/Sections (Master) dialog appears. 

2. Click  and a blank line will appear. 

3. Enter a description for the division in the Description field. 

4. To renumber a Division, click on it in the No. field and make your changes. 

5. Once you have created a new Division, you must create its accompanying section or sections. 
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Creating a New Section 

1. From the Master menu, click Divisions/Sections. The Divisions/Sections (Master) dialog appears. 

2. Click  and a blank line will appear. 

3. Enter a description for the Section in the Description field. 

4. To renumber a Section, click on it in the No. field and make your changes. 

5. Click  to place the new Section in your bid. 

 
Deleting a Division or Section 

1. From the Master menu, click Divisions/Sections. The Divisions/Sections (Master) dialog appears. 

2. Select the Division or Section you want to delete by highlighting it. 

3. Click .  The Delete Verification dialog will appear. 

 

NOTE:  Turn on all confirmation dialogs must be checked to receive this dialog.  To turn 
confirmation dialogs on or off go to Tools > Options, General tab, Confirmations. 

4. Click either Yes to delete or No to return to the Division/Section (Master) dialog. 

 

NOTE: See Section 10, Active Bid Sections for information on inserting Divisions and Sections into a bid.   
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Master Menu Cost Codes 

Cost Codes are used to group similar material and labor items into common categories. They are used to 
track and account for material and labor items in your bid reports. Categories like Wood, Tile and Insulation 
are examples of material cost codes and Finish, Hang Top Out and Install Mesh are examples of labor cost 
codes. 

 

1. To create a new Cost Code, from the Master menu, click Cost Codes. The Cost Code List (Master) 
dialog appears. 

2. Click . A blank line will appear. 

3. Enter a unique identifier in the Cost Code field. 

4. Enter a description for the Cost Code in the Description field. 

5. Enter a Type, Account Code, and Section (optional). 

6. Click  to exit the dialog. 
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Master Menu Account Codes 

Account Codes are codes used for tracking in external accounting packages.  You can include Account 
Codes on labor and material items, which allows you to export data directly from Quick Bid into your 
accounting hardware. You can use the same account codes that your accounting software uses or create 
new ones as needed. 

 

1. To create a new Account Code, from the Master menu, click Account Codes. The Account Code 
(Master) dialog appears. 

2. Click . A blank line will appear. 

3. Enter the Account Code and Description in their respective fields. 

4. Click  to exit the dialog. 
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Master Menu Payroll Classes 

Payroll Classes are used to separate your labor costs into specific installation tasks. Your labor reports use 
pay classes to isolate labor by trade.  The labor items on the Payroll tab are grouped by these classes.  You 
can add, change or delete from the Payroll Class List (Master). 

 

1. To create a new Payroll Class, from the Master menu, click Payroll Classes. The Payroll Class List 
(Master) dialog appears. 

2. Click  and the Payroll Class Detail (Master) dialog appears. 
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3. Enter a name in the Name field. 

4. Enter your numbers directly in the Base Wage, Fees, Insurance and Tax fields as needed for each 
Wage Type. See Section 6, Databases, Setting Up Wages and Burdens for instructions on creating 
additional wage types. 

NOTE:  You may leave a field blank if you don't use it to calculate labor or if you keep track of it 
elsewhere. 

NOTE:  The hourly wage and daily wage are calculated based on entries in the other fields and thus 
take no direct entries. 

5. Click .  The Payroll Class will now be listed in the Payroll Class List (Master) dialog. 

 

Master Menu Estimators 

You may want to input all of the estimators who will be working in a specific database.  Each database can 
contain a unique list of estimators.  Having an estimator in one database does not necessarily mean that 
estimator will be included in other databases.  Including estimators at the database level can save you time 
when working in bids by allowing you to pull from a list that has all of the estimator's information. 

1. To add an estimator, from the Master menu, click Estimators. The Estimator List (Master) dialog 
appears. 

 

2. Click  and type in the estimator's name in the blank cell that appears. The Login Name 
defaults to initials, but can be changed to whatever you choose. 



Section 5 – Master Menus Lists 

      55 

3. Once you have added the estimator, you can set Access Levels for the estimator.  An estimator’s 
access to a database is controlled by logging in with a password at the splash screen when Quick 
Bid is first opened.  Access is divided into four areas of the program: Master Items, Other's Bids, Bid 
Lists, Master and Payroll Classes.  Each area may be assigned a level of access: Full Access, No 
Access or Read–Only Access. 

NOTE: If Access rights are assigned, there must be at least one Administrator and each estimator 
must enter a login name and password. 

NOTE: Regardless of the access level assigned to an estimator, the estimator may always open and 
create a new bid using the current tables for his data. The estimator may change the prices for 
material and labor within his or her job, but may be denied the ability to modify the Master Tables 
(Master Lists) depending on access rights. 

a. Click . The Access Levels dialog appears. 

 

b. Select an Access Level from those in the Description field. If the estimator is to be an 
administrator, put a check in the box next to Set as System Administrator. This estimator 
will have Full Access to all Database Tables. 

c. Choosing any other Access Level will allow you to set the estimator's Access Level for each 
of the Database Tables. 

d. To set Access Levels for a specific Database Table, click on the cell next to the Database 
Table under the View column.  Select the Access Level for that table. 

e. To create a new Access Level, click .  A blank line will appear under the 
Description field.  Fill in the name you want to give the access level and assign levels 
accordingly.    
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f. Click  to take you back to the Estimator List (Master) dialog. 

4. Click . The new estimator will be added to the master list. 

 
Master Menu Job Statuses 
A job status represents the current state of the bid.  You can add, delete or lock a bid status.  Locking the bid 
by placing a check mark in the box next to the bid status will place it in a 'read only' status.  This will 
prevent changes being made to until the bid is unlocked. 

 

1. To create a new Job Status, from the Master menu, click Job Statuses. 

2. The Job Statuses (Master) dialog appears. 

3. Click . A blank line appears. 

4. Enter the name of the new Job Status. 

5. Click  to exit the dialog. 
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Master Menu Job Types 

A Job Type can be anything you want. Typically, Job Types refer to the actual item being built, such as a 
Church, Hospital, Parking Lot, etc. You can use whatever nomenclature you choose for Job Types. 

1. To create a new Job Type, from the Master menu, click Job Types. 

2. The Job Type List (Master) dialog appears. 

 

3. Click . A blank line appears. 

4. Enter the name of the new Job Type. 

5. Click  to exit the dialog. 

 
Master Menu Condition Types 

Condition Types describe the conditions you use in your bids. A Condition Type typically refers to the actual 
item, such as a Door, Partition, Shaft wall, etc. You can use whatever nomenclature you choose for 
Condition Types. 

1. To create a new Condition Type, from the Master menu, click Condition Types. 

2. The Condition Types (Master) dialog appears. 
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3. Click . A blank line appears. 

4. Enter the name of the new Condition Type. 

5. Click  to exit the dialog. 

 

Master Menu Condition Assemblies 

A Condition Assembly holds a saved set of material and labor items used to build a condition. It is like a 
template of items that you select to fill in your Condition Detail. You can save any conditions as an 
assembly.  From the Condition Assembly List (Master) you can add, change or delete condition assemblies. 

See Section 9, Condition Assemblies for details on creating, modifying and deleting condition assemblies. 

 

Master Menu Equipment Assemblies 

An Equipment Assembly can contain multiple items or it can be a single item. Equipment Assemblies are 
stored in the database and are available for use in any bid in that database. Using Equipment Assemblies can 
save a great deal of time when creating your bids. From the Equipment Assembly List (Master) you can add, 
change or delete equipment assemblies. 

NOTE:  See Section 9, Equipment  Assemblies for details on creating, modifying and deleting equipment 
assemblies. 
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Master Menu Other Assemblies 

An Other Assembly can contain multiple items or it can be a single item. Other Assemblies are stored in the 
database and are available for use in any bid in that database. Using Other Assemblies can save a great deal 
of time when creating your bids.  From the Other Assembly List (Master) you can add, change or delete 
other assemblies. 

NOTE:  See Section 9, Other  Assemblies for details on creating, modifying and deleting other assemblies. 
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Section 6 

Databases 
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Creating Databases 
Creating a database is the essential first step to working with the Quick Bid program.  A database holds all 
the information for you project. You can choose to have one or many databases.  Typically the use of 
multiple databases improves performance and creates ease in sharing.  Smaller databases run faster and 
when shared have fewer files at risk of corruption.  

Some clients create a database for each estimator, while others use one for each different geographic 
location.  This helps them use the default settings that match the needs of a particular project.   

There are two types of databases: Mircosoft Access and SQL Server.  Determine which you will be using, 
and follow the directions provided below for creating that type of database.  

 

Access Database 

1. From the File menu, click New > Database or click the New icon dropdown  and click 
Database or right-click anywhere in the Bid window and select New > Database. 

2. Select database type: MS Access, and click OK. 

 

3. In the Database Properties dialog box you will give the database a file name, indicate if login is 
required, select a measure mode, and set up the auto backup and compress schedules. 

 

a. Enter a File name if you want the database to be saved in the default location.  If you want 
to save the database in a location other than the default location, browse to the desired 
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location and enter a file name for your database.  When you return to the Database 
Properties (Access) dialog, you will see the file location pathway in the File name field.  

NOTE:  Database names cannot contain \ / : * ? ' < > | ; symbols. The name you give your 
database will appear in the database list and on your main bids screen. 

b. The Requires login box will not be active until after you create the database.  If you want to 
make the database password protected, proceed with the steps to create it then come back 
to Database Properties and check the box for this feature. 

c. In the Measure mode field, select either Imperial or Metric as the system of measurement to 
use.   See Section 4, Units of Measurement for more information.  All UOM boxes in the 
database will be based on the system of measurement you choose. 

d. Select how often you want an auto-backup, and indicate the number of backups you want 
to create.  At the scheduled time, Quick Bid will perform the auto-backup upon close of the 
application.  A dialog will appear letting you know that the backup is in progress.  

e. Select how often, if ever, you want to auto-compress the contents of your database to save 
disc space. 

f. Click OK. Your database will now be available and listed on the Bid Navigator. 

 

SQL Database 

WARNING:  On Center Software cannot support SQL server setups or assist in the administration or 
troubleshooting of a SQL server’s configuration.  Only staff with knowledge of the server environment and 
with appropriate expertise in server configuration and administration should perform these actions.  In some 
cases, a server may be configured in a way that would require additional steps not detailed in this process. 
These instructions are provided as a resource to be run at your own risk. 

This document assumes that Microsoft SQL Server™ (v. 8.0) has already been installed on a server running 
Microsoft™ Server 2003™, and the server meets the minimum system requirements for SQL Server™.  If 
SQL is not currently installed, we recommend that a certified IT professional assist you with the SQL setup 
and configuration. 

Brief Overview 

• The SQL database will be created from within Quick Bid. 

• Any existing database(s) that you want to synchronize (optional) with the SQL database to be 
created, must be visible at your Bids tab. 

• Windows Authentication should be used in most cases. 
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Step 1 - Install Quick Bid at Your Workstation 

You do not need to install Quick Bid on the server.  You must have the Quick Bid application installed at the 
workstation that you intend to follow these steps on. 

Step 2 - Place Any Master Access Database on Server (optional) 

If you have an existing Access (*.mdb) database that you want to synchronize with the SQL database to be 
created, please place the existing Access database in the C:\OCS Documents\QB location of the 
workstation you intend to follow these steps on. 

Step 3 – Create SQL Database 

1. Start Quick Bid. 

2. Once application opens, click File > New > Database. 

3. Select Microsoft SQL Server, then click OK. 

4. The Database Properties (SQL Server) dialog opens. 

5. Type the name of your SQL Server in the SQL Server field. 

6. Select appropriate server authentication under Connect using. 

7. Type in the Login name and Password. 

8. In the Database field, type a name for your database. 

9. Choose your Measure mode (typically Imperial) and Click OK 

10. Your database should now appear at the Bids tab. 

11. If you had an existing MS Access (*.mdb) database, it should be visible also. 

Step 4 – Synchronize SQL Database with Access Database (optional) 

If you have an existing database that you want to synchronize with the SQL Database you created during 
Step 3 please follow these steps.  See Synchronizing Databases, in this section, for instructions. 

Step 5 – Transfer Bids into SQL Database (optional) 

If you need to move bids from Access database to the SQL database, you must be able to see both databases 
in the Bid Navigator. 

1. Expand the existing Access database to see bids it contains. 

2. Drag and Drop the bid(s) from the Access database to the SQL database and release the mouse 
button. The bid begins to be copied. 
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Step 6 – Archive MS Access Database  (optional) 

Move the Access (*.mdb) database to a folder or CD that is not shared and not visible to Quick Bid. 

NOTE:  If you leave the Access (*.mdb) database visible, your estimators may accidentally work and create 
bids in the ‘old’ Access database as opposed to creating them in the newly created SQL database. 

Step 7 – Start Working In Your New SQL Database 

You should now be able to create bids in your newly created SQL database. If you require further technical 
assistance, contact Technical Support t at support@oncenter.com or 866-689-5687. 

 

Opening a Database 
More than one database can be stored on your computer or your server, and you can choose which 
databases appear on your screen.  All databases you create will appear in the Open Databases dialog. 

1. Right-click anywhere in the Bids tab window or the Bid Navigator window and select Open, or 

click  from the toolbar.  

2. Place a check in the check box next to the database name(s) you want to open. 

 

3. If your database is password protected, type in your Login Name and Password in the dialog that 

appears, then click . 
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4. To close a database-so that it doesn't appear on your screen-uncheck the check box next to the 
database name. 

NOTE: When you close a database, you do not lose any information in your bids. Closing the 
database removes the database from your Bids window only. This allows you to see only those 
databases you are actively using. 

 

Navigating Databases  
The Bid Navigator, located to the left of the main display window acts as a database and bid organizer. The 
Bid Navigator is set up in a folder tree structure with bids appearing directly below their parent databases.  
You can have as many databases open along with their respective bids as you want in the Bid Navigator. See 
Opening a Database, in this section, for more information. 

NOTE: Use the Expand and Collapse buttons to help you navigate the databases and bids within them. 
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Synchronizing Databases 
Synchronizing databases allows you to take information contained in the Master menu tables of one 
database and put that information into another database. You can also take the Access Levels table of one 
database and put the information into another database.  

When synchronizing databases, the database you are taking information from is called the Source database, 
and the database that you are putting information into is called the Destination database. Keep in mind that 
when you synchronize databases, no information is actually removed from the Source database, it is only 
being added to the Destination database. 

The synchronization process affects databases only and does not affect individual bids. The primary use of 
the Synchronization feature is so that you can easily create new databases and create all of the tables 
needed to complete a bid without having to manually input information. Some companies keep a Master 
Database and use this to create new databases, saving a great deal of time. 

When you synchronize a database, you can either synchronize all of the table or any combination of tables. 
Because information from one table may affect information in another table, it is usually best to Synchronize 
all Master menu tables.  

1. From the Tools menu, click Synchronize Databases.  The Synchronize Databases dialog appears.   
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2. Synchronize all Master menu tables by placing a check mark in the box next to Synchronize all 
Master menu tables, or uncheck the box and select only the tables you want to synchronize. 

3. Click . 

4. When synchronization is complete, you may open the database and begin your project.    

 

Sharing Databases 
Quick Bid databases may be shared among different users working at different work stations. The database 
can be stored on a network or on a user's computer. Quick Bid uses MS Windows file sharing applications 
to share databases. Because of this, it is recommended that you have your IT professional or Network 
Administrator set up folders and files for sharing. 

NOTE:  You will need to know the name of your Network domain and the name of the work station 
computer you are trying to access.  You will also need access rights to the workstation that holds the 
database you want.  Ask your IT professional or Network Administrator for assistance.  

Locate a Shared Database from Quick Bid 

1. From the File menu, click Open or click the Open icon  The Open Databases dialog appears. 

2. Click  and select Microsoft Access, then  in the Select Database Type 
dialog. The Database Properties (Access) dialog appears. 

3. If you know the file path to the database, enter it or click the Lookup icon  in 

the Database path field. The Select MS Access database dialog appears. 

4. Browse to the location of the shared database. 

5. Select the database you want and click . The database now appears in your Open 
Databases dialog. 

6. There should be a check mark in the box next to the name of the database. If there isn't one, check 
the box. 

7. The database will now appear in your Bid Navigator. You can now work in the database as you 
would a database that is stored on your own workstation. fabulous  
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Locked Bids in Shared Database 

Quick Bid allows only one user at a time to access a bid in a shared database.  When you open a bid in a 
shared database, the program will lock that bid.  This prevents any bid information discrepancies from 
arising.   A lock symbol on the Bid Navigator will indicate that the bid is locked (opened by another user). 

 
View User Locking the Bid 

1. Highlight the locked bid in the Bid Navigator.    
2. Right click on the bid.  The View Lock option will appear.  
3. Click the View Lock option to get User name, Date and Time. 

Only the Bids tab will be available to view when a bid is locked; all other tabs will be disabled.  The 
functions that enable the bid to be edited will also be disabled until the bid is unlocked.  There are two way 
to unlock a bid. 

1. The user in the bid exits the bid.   
2. The user is forced out of the bid through the unlock process. See steps below. 

Unlocking a Bid 
1. From the Bid Navigator highlight the database that has the locked bid. 
2. Right-click on the bid.  The Bid Context Menu will appear.   
3. Select Bid Locks.  The Locked Bid List dialog will appear.  

4. Click on the bid you wish to unlock, and click . 
NOTE: From On-Screen Takeoff, a user will be able to modify a bid locked in Quick Bid.  However, when 
the program saves, the information will not be updated.     
 

Setting Database Default Preferences 
Before you create your first bid in a new database, you need to set up your default preferences for the 
database.  These preferences are sometimes referred to as Master level preferences.  Setting up default 
preferences and master lists will provide time saving benefits and can ensure that your bids are accurate.   

1. Set up Master Lists.   

2. Set up Payroll Wages and Burdens. 

3. Set up Standard Default Markups for Profit and Overhead. 

4. Set up Default New Bid Options. 
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Setting Up Master Menu Lists 

Master lists hold important information that you will use in your bids.  See Section 5, Master Menu Lists for 
information on each of the master menu lists. 

 

Setting Up Wages and Burdens 

It is important to set up payroll wage types and burdens, because they appear throughout Quick Bid. Once 
you have set up wage types and burdens, you should set up the wages for each payroll class. 

Setting Up Wage Types 

1. To set up wage types, from the Tools menu, click Payroll Settings. The Payroll Settings dialog 
appears. 

 

2. Click the Wage Types tab and click . 

3. Enter the name of the new wage type. 

4. Click  to return to the Payroll Settings dialog. 

NOTE: Use the Move Up and Move Down buttons to reorder the list. 

Setting Up Burdens 

The Burdens tab allows for up to eight different burden descriptions. Fees, Insurance, and Tax are default 
burdens, but can be modified if you want. The Method and Cost Code for each burden can be modified at 
any time. 

1. To set up burdens, from the Tools menu, click Payroll Setting. The Payroll Settings dialog appears. 
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2. Click the Burdens tab. 

 

3. To create a new burden, enter a name in an open field. To change the name of a burden, select the 
field it is in and type over the name. 

4. Enter a Method for calculating burden— Amount Choosing or Percent. 

5. Enter a Cost Code or click the Lookup icon  to select from a list. 

NOTE: To separate burden items on your reports, you must assign a Cost Code to each line of 
burden. 

6. Place a check in the Active box to make a burden available to every Payroll Class. 

7. Once you set up the preliminary payroll information (wage types and burdens) you can begin 
assigning wages to your Payroll Classes. See Section 5, Master Menu Payroll Classes. 

NOTE:  When viewing the Markup Detail, you will find that Quick Bid combines all burdens and displays 
them as a single percentage. Burdens entered as monetary amounts are converted to percentages and then 
added to your burdens that are entered as percentages.  Example: A benefit package entered at $12.50 per 
hour, with a base rate of $25.00 would be converted to 50% of your base rate.  If your tax and insurance 
amounted to 25%, Quick Bid will show your total burden as 75% at the Markup Detail. 
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Setting Database Level Default Markups 

Database level default Markups are preset percentage entries for Escalation, Material Sales Tax, Overhead 
and Profit.  As you enter bid costs, these settings are automatically applied to material, labor, indirect costs, 
equipment and other costs.  Setting database-level defaults for markups and indirect expenses will cause all 
future bids to automatically use these settings. 

NOTE:  Settings for markups can be changed at the bid level if you choose. See Section 9, Markups for more 
information. 

NOTE: It is important that you understand how Markups affect your bid.  It may help you to first change 
these settings at the bid level through the Markups tabs rather than modifying these database-wide settings at 
the Tools menu.  Experiment with all the options.  Analyze the results on your reports.  When you are 
comfortable with the results, modify your markup and indirect expense database-level defaults as outlined 
below. 

1. From the Tools menu, click Default Markups/Indirect Expenses.  The Default Markup (Master) dialog 
appears. 
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Applying Markups to All Sections 

1. Double-click Default markup for all sections in the Default Markup (Master) dialog. The Default 
markup for all sections (Master) dialog appears. 

 

2. Make your entries and click  to return to the Default Markups (Master) dialog. 

3. Click OK.  Your markups will be set. 
 

Changing Section Markup Entries 

You can modify the settings in a section at any time.  Keep in mind that when you add new sections, they 
will contain the settings you input in the Default markup for all sections (Master) dialog. 

1. To modify the entries for a section, in the Default Markups (Master) dialog, click on a section, and 

click . The Default Markup for Section Name (Master) appears. 

2. Make your changes to the entries and click  to return to the Default Markups (Master) 
dialog. 
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Setting Database Level Default Indirect Expenses 

Indirect Expenses refer to expenses related to Stock, Clean, Supervision and Per Diem. Each indirect expense 
category has its own dialog in which you are able to add and modify the figures related to each expense.  

 

1. From the Tools menu, click Default Markups/Indirect Expenses. The Default Markups (Master) 
dialog appears. 

2. Make entries on the Stock tab.  The Stock tab allows you to enter stocking costs on all materials or 
payroll classes in the database. 

a. Choose a Calculation Method for Stock: To change the calculation method, click on the 
arrow in the Calculation Method filed and click on your preferred calculation method. 

• Material Quantity - calculates how much it costs to stock the job based on the quantity 
of materials in the job. 

• Material Cost - calculates how much it costs to stock the job based on the material 
costs in the job. 

• Labor Hours - calculates how much it costs to stock the job based on the amount of 
labor hours required. 
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b. Select results for the calculation method to can be shown as either Labor Cost or Material 
Cost.  To change how the result is shown, click the arrow in the Show result as field, and 
click on your preferred result method. 

c. Make any needed changes, additions or deletions to the Payroll Class, Percent, Installer, 
Wage Type or Cost Code.  This can be done by typing in the cells or using the Lookup 
buttons provided. 

3. The Clean tab allows you to enter cleaning costs for materials or payroll classes in the database.  

a. Determine Calculation Method and Show results as (same as Stock tab). 

b. Enter the Mat. (material) Cost Code, Cost and Cost Code. 

4. The Supervision tab allows you to enter supervision costs of a job.   

a. Click on the arrow in the Calculation method field and click on your preferred calculation 
method. 

• Labor Cost - calculates how much it costs to supervise a job based on the cost of labor 
in the job. 

• Labor Hours - calculates how much it costs to supervise a job based on the number of 
hours of labor in the job. 

b. Enter the Payroll Class, Wage Type, Percent, Supervisor, Wage Type and Cost Code. 

5. The Per Diem tab allows you to enter allowances for daily expenses for a particular pay class. 

a. Enter a number in the Per Hour or Per Day field for a Payroll Class.   

NOTE: Entering a number in one of these fields will automatically cause the other field to be 
filled in. These fields auto-populate in this way depending on the number of hours you have set 
in a normal work day. 

b. Enter a Cost Code and click  to return to the Markup Detail (Master) dialog. 
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NOTE:  Make sure to set up Indirect Expenses for each Payroll Class / Wage Type combination.  For 
example, if you are setting Stock for a Waterproofer and you use all three wage types in that payroll 
class, fill the entries for Union, Open and Sub. 
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Section 7 

Options 
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Choosing your application and new bid options is an important step before you begin bidding in a new 
database. Once you choose these settings, they will be applied to each bid created in the database.   

 

Setting Application Options 
Application options will be applied to every project in the database.  These options are set from the General, 
Category Codes and Folders tabs in the Options dialog.  

1. From the Tools menu, click Options.  

2. Choose options for each tab (General, Category Codes and Folders).  Each tab is also referenced in 
Program Help, Default New Bid Options. 

 

a. General tab - provides options for a variety of aspects of your database. A list of fields and 
functions follows. 

• Use Enter key to navigate in dialogs - This option allows you to move from field 
to field by hitting the enter key on your keyboard. 

• Lock labor Tab from global changes - This option prevents estimators from going 
to the Labor tab and entering in new labor prices that will change all the 
conditions in the entire bid. The Labor tab becomes a Read-Only screen. 

• Use Wage Type from Assemblies - When this option is selected, the assemblies 
always default with their original wage types (Union, Sub, etc.) and bypass the 
default wage type selected at the bid Cover Sheet. 
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• Show Text on Selected Toolbars - This option causes the Bid Toolbar to display 
text beside each button describing its function. 

• Create Master Item during Bid Copying - When copying a bid from one database 
to another, this option will automatically add the bid’s Items to the Master Items 
Table of the destination database. 

• Filter Cost Codes by Section - Allows cost codes to be filtered by section 

• Turn on all confirmation dialogs - This option will present a context window 
anytime you try to perform an action that merits a confirmation. This includes 
deletion of bids, conditions and payroll classes. 

• Ask Before Updating Master Material Pricing - This option will present a context 
window asking you to decide whether the changes you made to a material price 
in a bid should update the Master price. Any updates to the Master will affect all 
future bids. 

• Software Updates - Use this to select how often your software will automatically 
check for updates available for download. 

b. Category Codes tab - used in conjunction with your accounting programs.  Use this tab to 
enter category codes that your accounting program will recognize.  Refer to your 
accounting software product literature for information on importing. 

 

Enter the Category Code in the grid.  It can be up to 14 characters long and can be letters, 
numbers or a combination of both. 
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c. Folders tab - use to define the location of your Database and Backup folders. 

 

1. To locate a folder, click the Lookup icon . The Browse for Folder dialog 
appears. 

 

2. Navigate to your desired folder and select it. 

3. Once you have selected the folder you want, click  to return to the 
Folders tab. 
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Setting New Bid Options 
1. From the Tools menu, click Options.  

2. Choose options on each tab (New Bid, M/U Cost Codes and Lookups).  Each tab is also referenced 
in Program Help, Default New Bid Options. 

a. New Bid tab - provides options for a variety of aspects of your database. A list of fields and 
functions follows. 

 

• Next Bid Number - Enter the next bid number here. You can enter any number 
you want, as long as they are not repeated. 

• Bidding Company - This option allows you to automatically insert your company 
name at the cover sheet as the bidding company when you open a new bid. This 
name will appear on all of your bid reports and proposals. 

• Default Wage Type - This option allows you to choose a default wage type, 
which will be applied to each new bid you create. 

• Hours/Day - This option defines the hours in a work day. It’s the hours you pay 
per day. If you change your hours per day, production per hour will remain the 
same by default but production per day will change. So quantity, pieces, and 
time expressed in days are affected. 

• Days/Week - Enter the number of days in a regular work week. 
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• Markup Method - This option may be changed on the bid Cover Sheet for each 
new bid. The straight method applies markup to cost while the Gross Method 
applies it to the selling price. 
• Straight markup multiplies cost by a percentage.  In this example a 20% 
markup on cost would be (cost x 1.20 = total) or $1,000 x 1.20 = $1,200.   
• Gross Profit Margin, on the other hand, takes bid cost and divides it by the 
remainder of 1 minus the markup percentage.  In this example, a 20% Gross 
Profit Margin would be (cost / (1-20% = 80%) = Total) or $1,000 / 80% = $1,250. 

• Apply labor to additional waste quantity - This option allows Quick Bid to apply 
labor on any waste quantities or any quantity that is increased at the Materials tab 
when the round-up feature is applied. 

• Apply Default Indirect Expenses for - If you have set up indirect expenses at the 
Tools menu for stock, clean, supervision and per diem, when checked, this 
option applies indirect expenses to each section that holds indirect expense 
defaults. 

• Cover Page Report Text - This text box allows you to type in whatever you would 
like to always print as a cover page for your bid reports. 

b. M/U (Markup) Cost Codes tab - allows you to assign Cost Codes to Material, Labor, 
Equipment and Other Markup items. These codes are used to control the layout of 
information shown on Bid Reports and Bid Exports. 

 

1. To enter a Cost Code, click on the field you want to enter it into, or click the 

Lookup icon icon to select from a list. 
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2. To create a new Cost Code, click the Lookup icon in any field. In the Cost 

Code List dialog click . 

3. In the blank field that appears at the bottom of the list enter a Description, Type, 
Cost Code (how you want it to appear in lists), Account Code (if any) and Section. 

4. Once you have entered the information, click  to return to the M/U 
Cost Codes tab dialog. 

5. An alternate method for creating a new Cost Code is to type in a name for your 
Cost Code in one of the fields, and then hit Enter on your keyboard. 

6. Click  in the dialog that appears. The Cost Code List dialog appears. 

7. Enter information into the other fields as required, then click  to 
return to the M/U Cost Codes tab dialog. 

c. Lookups tab - allows you to select the Contact Type for various lookups. To modify a 
Contact Type, click the arrow in the respective field and select a type from the list. 
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Bids  
A bid is the estimated total cost of material and labor (including profit) for a given project.  Quick Bid 
provides an accurate and efficient way to create what was once a tedious and time consuming process. 
 

There are four ways to create a bid in Quick Bid: 

• Create a new bid from scratch. 

• Duplicate an existing bid. 

• Import an On-Screen Takeoff® file. 

• Send an On-Screen Takeoff bid to Quick Bid using Interactive or Manual Mode. 

NOTE:  See Section 12, Quick Bid & On-Screen Takeoff Interaction for instructions on how to create a 
bid using On-Screen Takeoff. 

  

Creating Bids  
1. From the File menu, click New > Bid or  

Click the New icon drop down and click Bid or  

Right-click anywhere in the Bids window, and select New > Bid or  

Hit the Insert button on your keyboard. 
2. When the Cover Sheet comes up, type the name of your bid in the Project Name field. 

3. Click .  Your new bid will appear in the Bid Navigator. 

NOTE: When you first create a Bid, the only field on the Cover Sheet that requires information is the Project 
Name field. There are other fields, however, that you may want to enter information into before you begin.  
See Bid Cover Sheet, in this section, for information about completing the Cover Sheet. 

 

Duplicating an Existing Bid  

1. Right-click on the bid, and select Duplicate, or 

Press Ctrl D from your keyboard, or  

From the Edit menu, select Duplicate 
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2. Click in the Duplicate Bid dialog. The duplicated bid will appear in the Bid Navigator 
list with the same name as the original bid.   

3. Double-click the bid to bring up the Cover Sheet and change the name in the Project Name field. 

NOTE:  The duplicated bid will have all the same properties as the original.  You should change the Project 
Name, and make any other changes, if needed, once it is created.   

 

Bid Cover Sheet 
Every bid, change order and alternate has a Cover Sheet.  The Cover Sheet allows you to create and store 
bid specific information.  The Bid Cover Sheet has five tabs: Job Site/Contacts, Preferences, Notes, Estimating 
Team and Results.   

NOTE: The Project Name is always a required entry.   However, it is recommended to select a Job Type and 
an Estimator.  These are used as filter fields on the Bid List and on the Bids tab. 
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Completing the Cover Sheet 

1. Select a Job Status by clicking the arrow next to the field, and select a status from the list. If you 

want to create a custom job status, type it in, and hit Enter.  Click  in the dialog box 
that appears.  See Section 5, Master Menu Job Statuses for details on creating new statuses.  

2. Select the Bidding Company by clicking the arrow next to the field, and select a company from the 
list. See Section 5, Master Menu Contacts for details on adding a company to your contact list. 

3. The Project Name field requires that you create a name for your bid.  Type in a name in the field. 

4. Select the Lead Estimator for the job by clicking the arrow next to the field and selecting one from 
the list.  See Section 5, Master Menu Estimators for details on adding estimators to your database. 

5. Select a Job Type by clicking the arrow next to the field, and select a status from the list.  If you want 

to create a new one, type it in, and hit Enter. Click  in the dialog box that appears.  See 
Section 5, Master Menu Job Types for details on creating new job types. 

6. The Bid Date field populates with the current date. To select another date, click the arrow and select 
a date from the calendar, or you can type in the date you want.   

7. The Bid Time field populates with the current time. To select another time, click the arrow and 
select a time from the list, or you can type in the time you want. 

8. The Total Sq. Size is an optional entry that accepts the square footage of a building or site area and 
is used in the Bid Analysis report to establish cost rations. 

9. Place a check in the box next to Auto sum to have Quick Bid automatically sum the cumulative 
total of all areas as you create the bid. 

10. Bid No. field auto-populates, but can be changed to any number you want. 

11. Job No. is an optional entry. Your job number can be a number or an alpha-numeric entry. 

12. Acct. ID is an optional entry. Your Account ID can be a number can be a number or an alpha-
numeric entry. 

13. Plans Date is an optional entry. To select another date, click the arrow and select a date from the 
calendar, or you can type in the date you want. 

14. Job Start is an optional entry. To select another date, click the arrow and select a date from the 
calendar, or you can type in the date you want. 

15. Job End is an optional entry. To select another date, click the arrow and select a date from the 
calendar, or you can type in the date you want. 
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16. Job Site/Contacts tab is the default tab that is active each time you open the Cover Sheet. 

• Job Site field is optional are to enter job site information. 

• Project Contacts field is where you can add any contacts for the job such as architect, 
owner, other subs, etc. Enter Company information first, then select a Type. 

17. Preferences tab allows you to set preferences for the bid you are in. Changing preferences here will 
not affect your database-level defaults.  See Setting Bid Preferences, in this section, for additional 
details. 

18. Notes tab provides you with a location to type in any notes you may want to include. These notes 
can be printed in a bid report. 

19. Estimating Team tab is used if you have multiple estimators sharing a database.  You can set access 

rights for each estimator. Click  to select the estimator(s) you would like listed.  Access Level 
can be updated by clicking in the appropriate cell and selecting the access level from the drop 
down list.   

Note: This tab will only allow for you to increase the access level for an estimator.  It changes the 
access level only for the open bid. See Section 5, Master Menu Estimators, for information on how 
to change access levels at a master level. 

20. Results tab is used to record the results of the bid. You can enter competitor information and 

whether they were awarded the bid or not. To search for a competitor, click the Lookup icon  
and select from the list in the Contacts (Master) dialog.  

 

Setting Bid Preferences 

1. Open the Cover Sheet and select the Preferences tab.  
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2. Select or type in your preference for each field.   

• Static - Select a Default Wage Type from the list. Enter the number of hours in a regular work 
day. Enter the number of days in a regular work week. 

• Calculation Options - Select a Markup Method. Place a check in the box if you want to Apply 
Labor to additional waste quantity, which will apply labor on any waste quantities or any 
quantity the is increased at the Materials tab when the round-up feature is used. 

• Apply Default Indirect Expenses for - If you have set up indirect expenses at the Tool menu for 
stock, clean, supervision and per diem, when checked, this option applies indirect expenses to 
each section that holds indirect expense defaults. 

• Cover Page Report Text - Type in text as you want it to appear on the cover page for your bid 
reports. 

• MWBE Requirements - Enter MWBE (Minority and Women -owned Business Enterprise) 
Requirement information here. 

NOTE: Setting bid preferences in this manner will affect the selected bid only, and will not affect your 
database default settings. 

 

Alternates  
An Alternate is an optional cost for a bid and can be turned on or off by accepting the alternate or not. The 
final bid total will reflect the total form the base bid and the totals from any accepted alternates. 

Because alternates are part of the bid, they must use the same bid items and payroll settings that are used in 
the base bid.  You can, however, change markups and indirect expenses for alternates. 

1. Select a Bid in the Bid Navigator, then from the File menu, click New > Alternate or  

Click the New icon dropdown and click Alternate or 

Right-click anywhere in the Bids window and select New > Alternate. The Alternate Cover Sheet 
dialog appears. 
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2. Enter a name for the Alternate in the Name field. 

3. Enter a job number in the Job No. field and an account identification in the Acct. ID field.  These 
are optional entries 

4. The Submitted date field will be populated with the current date.  You can change it by clicking the 
arrow next to the field and selecting a date from the calendar. 

5. Place a check in the box next to Accepted if you want to include the alternate totals into the bid 
grand total. 

6. Document important information about the alternate in the Notes window.   

7. Click .  The Condition tab for the alternate will opened. 

8. Build conditions for your alternate as you would for a normal bid, and add bid costs. See Section 9 
Conditions, Assemblies and Markups for more information. 

NOTE:  Alternates appear directly below their base bids. If you don't see an Alternate in the Bid Navigator, 
locate its base bid and click on the plus sign (+) to the left of the base bid name. The Alternate will appear 
below the base bid. 

NOTE:  You can come back to the Alternate Cover Sheet dialog to change acceptance or any other field.  
Double -click on the Alternate in the Bid Navigator, and the Alternate Cover Sheet dialog for will appear. 
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Change Orders 
A Change Order is a separate bid that accompanies a base bid. As the name implies, Change Orders reflect 
changes to some aspect of the base bid. As such, Change Orders and base bids can have different Payroll, 
Material pricing, Section Markups and Indirect Expense information. 

1. Select a Bid in the Bid Navigator, then from the File menu, click New > Change Order or 

Click the New icon dropdown and click Change Order or 

Right-click anywhere in the Bids window, and select New > Change Order. The Change Order 
Cover Sheet dialog appears. 

 

2. Enter a name for the Change Order in the C/O Name field. 

3. Enter a job number in the Job No. field, and account identification in the Acct. ID field.  These are 
optional entries 

4. Enter the Job Start and Job End dates in their respective fields, or click the arrow and select a date 
from the calendar.  

5. Place a check in the box next to Accepted if you want to include the change order in the base bid's 
grand total.  The Change Order will appear on the Bid Summary Report.    

6. Enter a value in the Total Sq. Size field or place a check in the box next to Auto sum to have the 
program calculate total size based on the values you apply to your condition(s). 

7. Document any important information in the Notes field. 
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8. Click  The program will open the Conditions tab. 

9. Build conditions for your Change Order as you would for a normal bid, and add bid costs. See 
Section 9, Conditions, Assemblies & Markups, for more information. 

NOTE:  Change Orders appear directly below their base bids. If you don't see a Change Order in the Bid 
Navigator, locate its base bid and click on the plus sign (+) to the left of the base bid name. The Change 
Order will appear below the base bid. 

NOTE:  You can come back to the Change Order Cover Sheet dialog to change acceptance or any other 
field.  Double -click on the Change Order in the Bid Navigator, and the Change Order Cover Sheet 
dialog for will appear. 
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Section 9 

Conditions, Assemblies & Markups 
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Conditions 
A Condition is a description of an object such as a floor, wall, door, etc.  A condition contains all of the 
information about a particular object. Conditions are typically built for each item.  You can create complex 
groups of materials and labor into each condition that occurs individually or in multiple areas.   

1. To create a new condition, from the File menu, click New > Condition or 

Click the New icon dropdown  and click Condition or 

Right-click anywhere in the Conditions tab window and select New Condition or 

From Bid Navigator, right-click anywhere in the window and select New > Condition. The 
Condition Detail dialog will appear. 

2. Enter information in the of the Condition Detail dialog to build your condition. 

 

 

 
Condition Detail 

In Quick Bid, conditions are created on the Condition Detail dialog.  It is important that you understand the 
layout and function of each area in the Condition Detail dialog, as this is where you will perform most of 
your work in Quick Bid.  The Condition Detail dialog consists of five main sections:  Condition Information 
Area, Section Totals Area, Notes Area, Detail Area and Detail Controls Area. 

 

 

Condition 
Information 
Area 

Section 
Totals Area 

Notes Area 

Detail  
Area 

Detail 
Controls 
Area
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Condition Information Area 

• Cond. No. (Condition Number) is automatically assigned to a condition.  It determines where on the 
Conditions tab it will be placed. The condition number can be modified to move up or down on the 
conditions list for convenience. 

• Name entered will show on all the reports and help identify the condition back to the drawings. 
Usually the entry will be a section or detail number, or a reference from an architectural schedule 
for doors, walls ceilings, finishes, etc. The condition name is user defined and is not supported with 
a drop down menu.   

• Type is used as an indexing devise for the Condition and Assembly lists. When Condition Details 
are assigned a Type from the lookup menu, the Conditions list can be sorted or grouped by Type.  
As an example, all columns would be grouped together at the conditions List. The Type also indexes 
the Assembly list so that similar conditions will be grouped together when the Assembly list is 
viewed in the expanded mode.  

• Area allows you to assign the condition to a specific building area or multiple building areas.   

• Multi-Area is used to assign quantities and counts across multiple areas. These areas include typical 
areas. Typical Areas are always listed at the top left, if they exist, and Building Areas will appear 
beneath them. 

• Quantity the amounts in both the primary (Quantity 1) and secondary fields (Quantity 2 & 3) comes 
directly from your takeoff and normally no UOM conversion is necessary.  If you take off an object 
in LF, then the quantity is entered in LF, etc.  You may enter a whole or fractional value. Example 
100 SF or 15.33 LF. In metric, we would enter millimeters or meters. Most labor or material items 
calculate from the Quantity 1 field.  Area quantities entered at the Multi Area list will be 
summarized and displayed at the condition in the proper quantity fields (1, 2 or 3).  

• Unit of measure (UOM) may be selected by using the drop-down menu button to the right of the 
Quantity field or you may use your keyboard to select a different UOM.  This UOM controls the 
initial default for the Totals View display.  When EA is used as the UOM (unit of measure), the 
physical dimensions of the object cannot be defined without a height and width or length. The 
Width and Depth fields automatically appear.  All three of these attributes may be entered to extract 
a physical size of the EA item.  When Width and Depth are entered, Quick Bid assumes you are 
building a four sided rectangular object, thus a perimeter value can be established (Width + Depth 
X 2).   

 

In effect, by entering width and depth you are assigning EA conditions a linear value so that 
materials set up to calculate linear values will work for the EA setup.  For example, a single column 
entered at the Condition detail, could be assigned a UOM of EA, a height of 10’-0”, a Width of 2’-0” 
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and a Depth of 3’-0”. If the code X-58 (gypsum board) were entered into the condition grid, the 
quantity calculation would be 200 SF.  1 EA x [ (width + depth) X 2] x Ht X Layers = Total SF of 
board 1 EA x [ ( 2’-0” + 3’-0” ) X 2] x 10’ X 2 layers = 200 SF of board. 

• Height is used as a factor to calculate quantities of certain material and labor items. If Imperial 
entries are made, both feet and inches must be entered. If the condition is 10 feet high, you must 
enter 1000, or 10 feet 00 inches.  If it’s 13’8”, you enter 1308.  If you enter 49, the result will be 
4’1” in the height column.  Metric heights are entered in millimeters.  

• Count: Count represents the number of reoccurrences for this condition type.  The columns on the 
right (Qty 1,2,3 and Count) will automatically sum their totals and enter them back at the 
corresponding Condition Detail fields.  

 
Section Totals Area 

• The grid area displays section totals.  It holds the condition pricing information resulting form the 
labor and material entered in the Condition Detail along with the markups entered at the Markup 
Detail.   

• Totals View is directly related to the Condition UOM and controls the displayed section totals. 
Changing the UOM at the drop down menu changes the Section Totals results. For example, the 
marked up price of a condition entered in LF may be viewed in SF or SY. Changing the Totals View 
only changes the display in the Condition Detail but does not control the results shown on the 
printed reports.  

• View Markup button allows you to view all of the direct and indirect expenses in the grid display.  
When selected, this button opens the View Markup dialog. This read-only window displays the 
costs for material and labor summarized from the Condition Detail. The View Markup dialog will 
also show indirect expenses like escalation, profit, material sales tax and labor burden if they were 
previously entered.  It is specific to the opened Condition Detail and justifies the value shown for 
the Condition Detail.  

 

Condition Notes Area 

This is a text box used for entering notes. Using notes is a way to conveniently communicate important 
information that pertains to the building of the condition.  You can use notes to keep a record of unusual 
codes or out of the ordinary instructions regarding the condition.  You can even print the notes on the Bid 
Summary, Production and Field reports to communicate with field personnel.   
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Detail Area 

The lower part of the Condition Detail is known as the (Item) Detail Area and holds all the material and 
labor items required to build the condition.  The Detail Area uses a grid divided into columns which display 
default information for items entered on each row.  These columns hold Item codes, default settings, cost 
tracking information, material and labor values as well as production information.   
 
When an item code is entered into the Detail Area, the defaults are displayed to show how the quantity was 
calculated.   The height, on-centers, layers, and even the quantity can be changed. Changing these values 
only affects this condition and does not affect the Item record or any other conditions within the job.  Labor 
is reported by Unit Cost, Production, Crew Time and Total money. Since these values are interrelated, 
changing one value automatically updates the others. 
 

• Sect (Section) displays the section number which defaults from the Master Item record.  Section 
numbers may be temporarily changed at the condition without affecting the Master record. 

• Item displays the Item code and functions as the main entry field for a detail item 

• Lab. Code (Labor Cost Code) displays the Item’s default labor Cost Code if labor is associated. Also 
allows direct entry changes if Item is setup as a material and labor Item 

• Height Displays the item’s height (If the item is set up as horizontal and continuous, this field will be 
disabled from direct entry changes) 

• OC (On Center) represents the on center value for a material item. 

• Layers displays the number of layers or rows applied to this item. 

• Qty (Quantity) represents the amount of this item needed to build this condition. 

• UOM (Unit of Measure) represents the unit of measure specified for this item’s quantity. 

• Size displays the size, style or mixture for this item.  Some items are set up with multiple sizes and 
will be shown in a blue field at the size column.  These too may be changed at the Size column by 
simply clicking the size displayed and selecting another size from the drop down menu. 

• Mat. Price (Material Price) displays the default cost for this item.  Changes to the material price for 
this item can be made here by clicking into the cell and typing the change.  material prices 
displayed in the Detail Area come from the bid Item record. If you highlight the price and enter a 
new value, a pop up dialog will ask to update the Master Material price.  Selecting ‘Yes’ will update 
the price within the current bid and update the Master price. Selecting ‘No’ will update the current 
Bid but the Master price will remain unchanged.   
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• Per displays the method of pricing the item. 

• Lab Cost displays the cost of labor associated with this item. 

• Wage Type shows the wage type applied to the labor. 

• Crew displays the number of men in a crew required for the production selected, in the form of a 
button. Click the button to see what payroll classes are assigned to the crew. 

• % Base displays your adjusted labor as a percentage of the original labor default.  Any percentage 
above 100% of your base default rate is flagged in red while less than 100% is flagged in blue.  This 
column allows you to change your base default production rates with a percentage entry. When a 
labor item is entered into the condition, it defaults to its base production rate, represented as 100%.   

• Qty/Day (Quantity/Day) shows the quantity being produced per day or hour. 

• Units/Day shows the pieces being installed per day or hour. 

• Crew/Day shows the time required to install the condition quantity based upon the production 
entered. 

• Mat Total (Material Total) provides a line item material cost total based upon the quantity x the unit 
material price. 

• Lab Total (Labor Total) provides a total amount needed for the labor in the item. 

 

Detail Controls Area 

The Condition Detail has several buttons located at the bottom of the dialog for you to use.  

• Modify Item button opens the bid Item Detail for the highlighted item.  The Item Detail allows you 
to edit the item information from material pricing to labor pricing.  Editing the bid Item Detail, will 
only affect the item for this bid.  It will not change the item at the database/ master level.   

For details about the Item Detail dialog see Section 5, Master Menu Items.  The bid level and master 
level dialogs have the same properties.  They just store information in different areas.   

NOTE: Master level dialogs are labeled (Master).  Changes made at a Master dialog will change all 
present and future bids.  Changes made at the bid level will only affect the current bid. 

• Insert button inserts a new line for another item. 

• Delete button deletes a highlighted Item. 

• Move up button moves a highlighted item up one line. 
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• Move down button moves a highlighted item down one line. 

• Assembly button opens the Condition Assembly List (Master) dialog.  This dialog contains a library 
of condition templates that contain materials and labor. 

• Labor Adjust button accesses the Labor Adjust dialog that allows you to change labor production on 
a single labor code or across all labor codes. 

• Print button gives you the option to print the current, selected or all conditions; and show details, 
section markups or notes. 

• Next button views the next Condition Detail in the Conditions list 

• Previous button views the previous Condition Detail in the Conditions list 

• Verified box allows you to keep track of your progress setting up that condition.  You have an 
option of either placing a check mark in the box with a click or clicking it again will fill the box.  
The check mark will be displayed in red on the Conditions tab next to the condition.  If the box is 
filled, it will be represented with a black check mark on the Conditions tab. Use this feature for your 
tracking needs. 

• Copy & Paste buttons will copy and paste conditions.  You can use these buttons between 
conditions listed on your Conditions tab. 

 

Assemblies 
An Assembly is a saved group of items that can be used repeatedly. Once an assembly is created, using it is 
as simple as selecting it from a list. All of the saved items that it contains will fill in the appropriate fields. For 
example, creating a condition assembly saves a template of Condition Detail Items. 

No matter when an assembly was originally saved, material and labor pricing will always reference the bid 
records first. If they are not already used in the bid, they will come from the Database (Master) records. This 
ensures that your bid always references the most current prices. 

With Quick Bid, you can create three different types of assemblies: Condition, Equipment and Other 
Assemblies. 

 

Condition Assemblies 

A Condition Assembly holds a saved set of material and labor items used to build a condition.  It is like a 
template of Items that you select to fill in your Condition Detail. You can save any conditions as an 
assembly. 
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The following items detail some important considerations for working with Condition Assemblies: 

• Condition Assemblies save production values rather than money. If a labor item is saved with a 
production rate of 1000SF, the same production will default to all future conditions. This method 
assures you that if labor rates are modified, the assemblies automatically update to the new rates 
(i.e. new labor rate divided by 1000SF = new unit price). 

• When a condition is saved to an assembly with the original default heights for material items, that 
assembly may be used for any similar condition regardless of height. In other words, you can save a 
wall at 10’ but use the same assembly to build a 14’ wall. The material quantities will recalculate 
correctly. However, labor will default at the same production rates that were originally saved to the 
assembly. So labor should be readjusted each time an assembly is used in a new condition. 

• Assemblies remember proportional values for material items that have their quantity method set up 
as a direct entry. For instance, a condition may be set up with a quantity of 1000 SF. A direct entry 
item such as metal trim is entered and assigned an item quantity of 100 LF. The assembly will 
remember that relationship of 1 to 10 and apply that same ratio to future conditions. 

 

Creating Condition Assemblies 

Condition Assemblies can be created in either the Condition Detail dialog or the Condition Assembly 
Detail (Master) dialog. The procedures for creating assemblies are the same for both dialogs.  

1. Before you can create an Assembly, you will need to enter all of the required items you want to 
include in that assembly. See Condition Detail, in this section, for information about entering 
material and labor items. 

2. Once you have entered the necessary items, click . The Condition Assembly List 
(Master) dialog appears. 
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3. Click .  If you entered the items in the Condition Detail, the Condition Assembly Detail 
(Master) dialog appears and is populated with all of the items you entered on the Condition detail 

NOTE: No matter where you entered the items, you will end up on the Condition Assembly Detail 
(Master) dialog. 

4. Enter or modify the condition Name with a unique description for the assembly. 

5. Assign a Type to the condition.  Because the Condition Assembly List is presented in an expandable 
tree format, assemblies are indexed into groups through the Type field. 

6. Enter the Estimator or use the Lookup button to pick from a list. 

7. You may want to make important modifications to the condition assembly like entering more 
detailed notes regarding the use of the assembly or changing the order in which the items appear in 
the Detail Area to reflect the way the condition is built. 

8. When you are done entering or modifying information, click  to accept and save the 
new assembly. 

 

Using Condition Assemblies 

1. To insert an assembly into a condition, click  on the Condition Detail dialog. The 
Condition Assembly List (Master) dialog appears. 

2. Click on the plus sign (+) next to an Assembly Description to expand the list under that Description. 
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3. Double-click an assembly or click  to choose the assembly. The assembly will appear 
in your Condition Detail. 

NOTE: It is always a good idea to verify that labor costs, material costs, layers, etc. are accurate. 

NOTE: If you re-enter the Assembly List from the Condition Detail and choose Select, a dialog will appear 
called Assembly Select. This dialog is requesting direction as to where it should insert the selected assembly 
into the current Condition Detail. If you click Append, the selected assembly will be added to the condition 
(even if there are existing items previously entered). If you click Replace, Quick Bid will remove the existing 
Item(s) and replace it with your selected assembly. If you click Cancel, the Assembly list will be closed and 
no changes will be made at the Condition Detail. 

 

Equipment Assemblies 

An Equipment Assembly can contain multiple items or it can be a single item. Equipment Assemblies are 
stored in the database and are available for use in any bid in that database. Using Equipment Assemblies can 
save a great deal of time when creating your bids. 

 
Creating Equipment Assemblies 

1. From the Master menu, click Equipment Assemblies or click the Equip tab. 

2. Highlight each piece of equipment that you want to include in the assembly. 

NOTE: To select multiple items, press Ctrl on your keyboard and while holding this button down, 
make your selections. 

3. If you have no pieces of equipment created in your bid you will need to create them. See Section 4 
Equip Tab for information on creating equipment records. 

4. Once you have made your selections, right-click anywhere in the Equip tab window and select New 
Equipment Assembly from the menu. The Equipment Assembly (Master) dialog appears. 

5. Give your assembly a name and enter an Owner or click the Lookup icon  to select from a list. 
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Using Equipment Assemblies 
1. Click the Equip tab. 

2. Right-click anywhere in the Equip tab window and select Insert Equipment Assembly from the menu 
or press Insert on your keyboard. 

1. Click on the assembly or assemblies you want to add to the bid and click  to return to 
the Equip tab. Your assemblies along with their attributes will be added to your bid. 

 

Other Assemblies 

An Other Assembly can contain multiple items or it can be a single item. Other Assemblies are stored in the 
database and are available for use in any bid in that database. Using Other Assemblies can save a great deal 
of time when creating your bids. 

 

Creating Other Assemblies 

1. Click the Other tab. 

2. If you have no pieces of equipment created in your bid you will need to create them. See Section 4, 
Other Tab for information on creating Other records. 

3. Highlight each item that you want to be included in the assembly. 

NOTE: To select multiple items, press Ctrl on your keyboard and while holding this button down, 
make your selections. 

4. Once you have made your selections, right-click anywhere in the Other tab window and select 
New Other Assembly from the menu. The Other Assembly (Master) dialog appears. 

5. Give your assembly a name and enter an Owner, or click the Lookup icon  to select from a list. 

 

Using Other Assemblies 

1. Click the Other tab. 

2. Right-click anywhere in the Other tab window and select Insert Other Assembly from the menu or 
press Insert on your keyboard. 
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3. Click on the assembly or assemblies you want to add to the bid and click  to return to 
the Other tab. Your assemblies along with their attributes will be added to your bid.  

 

Markups 
Markups come in three varieties in Quick Bid: Section Markups, Additional Markups and Indirect Expenses.  
At the bid level, all of these markups are created in the Markups tab and can be modified in the Markup 
Details dialog for each markup. 

 

Section Markups  

Section markups refer to overhead, profit, tax, burden, and escalation applied to each section used in the 
bid.    

• Overhead refers to general operating expenses. Overhead is applied as a percentage to your total 
costs (material, labor, indirect costs, sales tax and labor burden). You may prefer to include 
Overhead in your Profit line, thus no entry would be made in the Overhead field. Overhead is 
considered part of your cost and is marked up with profit. 

• Profit You can enter a percentage of profit you want to apply to material, labor, equipment, and 
other costs. Profit is applied to the Overhead cumulatively. On the Markup Detail, there are controls 
adjacent to the Indirect costs buttons (stock, clean, etc.) that turn off the Overhead and Profit for 
each of these expenses. 

• Tax/Burden The word Tax refers sales tax on material while Burden refers to taxes, fees, and 
insurance on labor. Tax can be changed directly in the Markup Detail dialog on Material, 
Equipment and Other. However, Burden can only be changed at the Payroll tab. 

• Escalation is a global modifier for costs associated with material, labor, equipment, and others and 
is job specific.  Escalation is expressed as a percentage and may be entered as a positive or negative 
value. Sales taxes are applied to escalation values that are assigned to materials. However, labor 
burden is not applied to labor escalation. Overhead and Profit can be applied to escalation. 
Escalation is an added cost to your bid and does not change unit cost pricing at the Condition 
Detail. It will, however, affect the selling price of each condition. 

Section markups can be calculated by two methods in Quick Bid: Straight or Gross Margin. 

• Straight Markup multiplies cost by a set percentage. Cost (100%+X%) = Total 
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• Gross Margin Markup takes bid cost and divides it by the remainder of 1 minus the markup 
percentage. Cost / (1-GM%) = Total 

 

Adjusting Section Markups 

1. Click the Markups tab. 

2. Click on the section you want to make adjustments to and either right-click and select Show Markup 
Detail from the menu or hit Enter on your keyboard. The Markup Detail dialog appears. 

 

3. Make your new entry and hit Enter on your keyboard. All other fields affected by your change will 
be updated. 

4. Use the   and  buttons to make adjustments to the previous and next 
sections listed on the Markups tab.   

5. Clicking  or pressing the F2 key on the keyboard will bring up the notes section.  Type 
notes that relate to the markups for your reference. 

NOTE: Only those fields with white backgrounds can be adjusted. 
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Additional Markups  

Additional Markups  generally refer to fees and charges applied to bid totals. Additional Markups are 
sometimes referred to as Bid Markups. In Quick Bid, however, the term Additional Markup is used.  You can 
include anything you like here. Many estimators enter special fees, insurance, bond expensed, etc. as 
Additional Markups. 

 

Creating and Adjusting Additional Markups 

1. On the Markups tab, click . The Configure Additional Markups dialog appears. 

2. Enter a Description for your markup. You can call it whatever you like. 

3. Enter a Method or click the arrow to select from a list. 

 

• Amount - Adds a specific amount to your bid total. 

• Cost Per Thousand - Adds an amount to every 1000 dollars of your Apply To field. 

• Percent - Adds a percentage to your bid total based on your Apply To field. 

• Subtotal - Creates a subtotal entry at the Markups tab that totals all costs listed before it. 

4. Enter an Apply To (result) or click the arrow to select from a list. 

5. Enter a Value. 

6. Click  to return to the Markups tab window, or click  to add another additional 
markup.  You can add as many additional markups as you like to your bid. Quick Bid allows you to 
add these markups and then decide whether you want to apply them to the bid or not. 

• To apply all of your Additional Markups to a bid, click  in the Configure Additional 
Markups dialog. All of the markups will be applied to your bid. 

• To use default settings and not the additional markups, click  and none of your 
additional markups will be applied to your bid. 
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• To save your additional markups configurations as defaults click . 

NOTE: If you are a self performing contractor and you have entered Subcontractors to your bid, your markup 
or profit on subcontractors must be added in the Configure Bid Totals grid. Likewise, if you are a general 
contractor, your fees or profit are entered there and would apply to all your bid costs. 

 

Indirect Expenses  

Indirect Expenses refer to expenses related to Stock, Clean, Supervision and Per Diem. Each indirect expense 
category has its own dialog in which you are able to add and modify the figures related to each expense. 

 
Adjusting Indirect Expenses 

1. Click the Markups tab. 

2. Click on the section you want to make adjustments to and either right-click and select Show Markup 
Detail from the menu or hit Enter on your keyboard. The Markup Detail dialog appears. 

3. Make your new entry and hit Enter on your keyboard. All other fields affected by your change will 
be updated. 

NOTE: Only those fields with white backgrounds can be adjusted. 





Section 10 – Areas, Sections, Sets & Chained Items 

      111 

Section 10 

Areas, Sections, Sets &        
Chained Items 



Section 10 – Areas, Sections, Sets & Chained Items 

112 

Bid Areas 
Bid Areas are defined locations within a single bid like buildings, floors, levels, wings, phases, zones, or 
rooms that are common to separate locations. For instance, for a multi-story building, the separate floors 
may be exactly the same. Creating a Bid Area allows you to perform the takeoff once and then apply it to 
multiple locations. 

Area names generally refer to the contract drawings. The estimator has full control over what areas are 
called. 

Quick Bid uses Bid Areas to calculate accumulated costs charged to these specific locations. Reports can 
then be generated to display information and quantities for each specific building area that has been used. 
Follow the steps below to create a bid area. 

1. To work with Bid Areas, click  next to the Area dropdown menu  on 

the Image tab or select  on the Cover Sheet. The Bid Areas dialog appears. 

2. To add a new area, select  and enter the name of your area. 

3. To add multiple subsets to an area, such as multiple floors to the west wing below, select 

 and select a name from the Area Quick Add dialog drop-down list, or type in the name 
for the area you want to create. This is an example of having an area within an area. 

4. Type a range in the From and To fields such as 1 to 5 (see below) and click . 

5. To indent or outdent and area to assign it to a parent area, highlight the desired area and select 

either  or  directly beneath the parent area you want to assign it to. 

6. To move areas up or down in the list, select  or  as desired. 

7. To delete an area, highlight the desired area and click . 

Bid Areas can be grouped in a logical manner with parent child relationships. You can make an area a 
subordinate of a larger area by Indenting and Outdenting when necessary. An example of this would be if 
you had a 10 story building and 8 units on each floor. You would first use Quick Add to create your 10 
floors but then create 8 units within each floor. This would allow more specific data to be derived from your 
reports.  Unit specific costs and estimates could be generated per unit using this method 

NOTE: A plus sign (+) next to any Area Name indicates that there are subordinate areas within that defined 
area. 
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Typical Areas 
A project can have several conditions that, when combined together, create a typical area like apartment 
units, hotel suites, townhouses, lobby areas, restrooms, etc. The Typical Area feature allows the estimator to 
assign a count for each typical unit within a building or project and only have to perform the takeoff for one 
unit. When properly entered, Quick Bid will split out your reports for each typical unit, floor, building, etc. 
or report a grand total for the bid. 

Since a Condition Detail is restricted to just one height, you may consider tagging your Typical Areas with a 
height value. Example: Apt. 2B – 8-6” , Apt. 2B – 10-”. This will help you if your project has multiple deck 
heights or if specific wall types require separate conditions of each height of the same wall. Be mindful of 
the heights when entering these quantities. When this step is completed, Quick Bid will have a total count of 
each Typical Unit, a breakdown for each floor and subsequently, a total for each area. 

To set up an estimate using Typical Areas, you must first set up Bid Areas. Note that you can have multiple 
Typical Areas for a given Bid Area. 

1. To create Typical Areas, from the Bid menu, select Show Typical Areas or click  on the Cover Sheet. 
The Typical Areas dialog will appear. 

 

2. Click  and assign a name to your typical area in the Typical Area dialog that appears. 

3. The Typical Area will appear in a column next to the Bid Area column. 

4. You can then enter the number of times your Typical Area appears in each Bid Area. 



Section 10 – Areas, Sections, Sets & Chained Items 

114 

NOTE: Use the Fill Down and Fill Right buttons to repeat counts down columns and across rows. 

Since a Condition Detail is restricted to just one height, you may consider tagging your Typical Areas with a 
height value. Example: Apt. 2B – 8-6” , Apt. 2B – 10-”. This will help you if your project has multiple deck 
heights or if specific wall types require separate conditions of each height of the same wall. Be mindful of 
the heights when entering these quantities. When this step is completed, Quick Bid will have a total count of 
each Typical Unit, a breakdown for each floor and subsequently, a total for each area. 

 

Active Bid Sections 
Quick Bid provides an opportunity for General Contractors to preset a scope of CSI sections for a specific 
job. In fact, templates may be set up for different categories of work. Activated sections will be displayed in 
numerical order by Division at the Subcontractor list (Subs tab). This display allows the Contractor to quickly 
check the Subs list on bid day to determine if there is a need to plug a number or determine if there is full 
coverage from his subs. 

1. From the Bid menu, click the Select Active Sections. The Select Active Bid Sections dialog appears. 

 

2. Check every division or section you want to activate.   
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This is a select dialog. Select dialogs are available at the bid level. You can add and delete divisions and 
sections and select them for your bid. Select dialogs will always have a Select button at the top. 

       

NOTE: The Divisions/Sections dialogs look and act similarly. The only difference is that at the bid level, you 
are able to select a Section for use in a bid, whereas in the Master level, you are viewing the Master record. 
Any divisions or sections you create at the Master level will be available to all bids in the database. To 
include a section, however, you must be in a bid. 

 

Named Sets 
If a set of bid sections are common to every bid, you can save them as a Named Set. 

1. To save a set of sections as a named set, click  at the bottom of the Select Active Bid 
Sections dialog. 

2. Enter a name in the field that appears. 

3. After you have made your selections and created named sets, click  to exit the dialog. 
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Chained Items 
A Chain is a group of related material items bound to a single Item code.  At the Condition Detail a 
Chain of Items allows you to type one Item code which will automatically pull in additional Item 
codes. For instance, entering the acoustical grid code DX24 at the Condition Detail will bring in a 
total of nine different Items.  

To enter a Chain, click the NEW button and type in or select an Item from the Items List. The Items 
displayed on the menu come from your Master Items List and are not uniquely built for the Chain 
applications.  

Entering a new Code also brings in the Item’s description. If the new Item has multiple sizes or if you 
have selected an Item with styles, then you may enter that specific information at the Size/Style 
column using the drop down menu.  

Having multiple Items chained together in an Item Detail is a great feature that can allow you to enter 
one Item Code which will in turn bring multiple items regarding materials and/or labor in one easy 
step. 
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Reports 
Quick Bid provides a multitude of reports to view your bidding project.  The reports are sorted into four 
categories: Bid Reports, Analysis Reports, Labor Reports and Materials Reports.  Reports can be as detailed 
or as general as you desire.  The Options that you choose to include will help determine what each report 
will include.   

NOTE:  All Quick Bid reports are generated using Crystal Reports TM software. 

 

1. From the Bid Toolbar, click .  The Bid Reports dialog will appear. See Bid Report 
Dialog, in this section, for more information about each section of this dialog. 

2. To choose which reports to print, which divisions/sections to allow, and which areas/typical areas to 
allow, place a check in the box next to the report, division/section, and area/typical area.  

NOTE: These categories can be expanded or collapsed by clicking the plus sign (+) or the minus 
sign (-) respectively. 

NOTE: Use  or  buttons in each section to select either all or none. 

3. Choose to include accepted alternates and/or change orders by placing a check in the boxes under 
Global Options. 

4. Set up your page, preview your reports, refresh report data or print reports by selecting the 
appropriate button. See Bid Reports Dialog for more information.  
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Bid Reports Dialog 

• Select Reports field lists all Quick Bid reports, and option boxes for modifying the content of reports. 

o Options button will open the Modify Options dialog for each report. This dialog is similar for all 
reports, however, options will vary depending on what report you are using. 

 

o Place a check in the box next to the option(s) you want to include on your report. 

o Use the  and  to scroll through the reports lists. 

o Click  after you have made your selections to return to the Bid Reports dialog. 

• Divisions/Sections to allow field lists all Divisions and Sections in use in the bid. You may select 
which Divisions or Sections to include in your report by checking and unchecking the boxes in the 
field. 

• Areas/Typical Areas to allow field lists all Areas and Typical Areas in use in the bid. You may select 
which Areas and Typical Areas to include in your report by checking and unchecking the boxes in 
the field. 

• Global Options boxes give an option to choose to include accepted alternates, accepted change 
orders, or both on you reports. 

• Report Library button opens the Reports Library dialog. Choose which reports you want to appear in 
the Bid Reports dialog by moving them in and out of the Reports Library. Those reports in the 
Reports Library will not appear in the Bid Reports dialog. You can choose all the reports in a 
category or certain reports. 

The following example shows that all of the Analysis Reports will be left off of the Bid Reports 
dialog, along with the Purchasing Report from the Materials Reports category. 
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• Page Setup button opens the Page Setup dialog.  The options selected here act as the reports 
printing instructions. 

 

• Refresh Report Data button is an interface with the Custom Reports feature.  See Custom Reports, in 
this section, for more information.  

• Preview button will allow you to view the report on your screen. 

• Print button will open the Print dialog and allow you to print reports. 

• Cancel button will close the Bid Reports dialog 
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Bid Reports 

There are three reports in the Bid Reports category. These reports provide information about selling price, 
markup structure, and cost by cost code. 

• Bid Cover Page Text will print the text entered on the Cover Sheet dialog, Preferences tab. 

• Bid Summary report shows a list of all conditions with their height, quantities, count and unit selling 
prices for material and labor.  You can display the conditions by area, or by CSI section with sub-
totals or grand totals.  You can also show duration expressed in hours or days. It lists the selling 
price of items assigned at the Subs, Equip and Other tabs.  

• Section Markup report displays labor and material costs with indirect expenses, sales tax on 
materials, burdens on labor and markups applied to the cost. The cost information displayed is 
derived from the Condition Details. 

• Job Cost Summary report shows a complete breakdown of all labor and material costs by cost code. 
A labor cost is summarized by labor code showing the quantity, unit cost, amount and production 
expressed in time by line item.  Material cost is summarized by category showing the quantity, unit 
cost and amount. 

 
Analysis Reports 

There are four reports in the Analysis Reports category. These reports provide information about material 
and labor costs. 

• Cost per Sq. Size report allows you to compare the unit price of this bid against historical cost data. 
This report is created by taking the total selling price of the bid and dividing it by the total square 
size, which results in a unit price per square size. The report options allow you to view the entire 
project or break down the report by area locations. This report requires the square area to be 
entered at the bid Cover Sheet for either the whole building or for each individual area at the Bid 
Areas list. 

• Labor Risk report allows you to evaluate the percentage of labor risk by comparing your burdened 
labor against your combined overhead and profit applied to both material and labor.  In other 
words, gross markup vs. gross labor cost. The percentage resulting from this calculation may be 
compared to your historical data of similar jobs.  

• Cost Percentages report splits up the selling price for the basic components of the bid and displays a 
percentage for each component against the total selling price. This report separates the amount in 
your bid for material, labor, subs, equipment and other charges; and expresses these amounts as a 
percentage of the total bid. 
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• Unit Cost by Cost Code report allows you to evaluate a unit selling price based on the quantity of a 
specific group of materials.  This report displays all your material quantities by material cost code. 
The total bid price is divided by the quantity of a material group to extract a unit selling price per 
unit. Since estimators key on different materials for this ratio, the report lists all material cost codes 
but they have no relationship to each other. 

 
Labor Reports 

There are three reports in the Labor Reports category. These reports provide information about all aspects of 
labor in a bid. 

• Field Report provides a full breakdown of the bid by condition.  Each condition shows material 
quantities and sizes.  Each condition shows labor by labor code, crew size, production per 
day/hour, and total time required to complete that labor code. 

• Payroll Report provides a full breakdown of labor by pay class. Each pay class shows the base rate, 
gross burden rate, total hours, fees, insurance, taxes and the gross pay. 

• Production Report is similar to the Field Report except that it breaks down labor only by Labor Cost 
Code for each condition. 

 

Materials Reports  

There are three reports in the Materials Reports category.  These reports provide information about all the 
materials in a bid. 

• Vendor Quote Sheet provides a list of materials to be sent to a supply yard for a material quote. The 
report indicates quantities and sizes and has a field for your vendor to insert pricing and a date to 
guarantee the prices through. 

• Purchasing Report provides a list of all materials required to complete the bid. 

• Stocking Report provides a list of materials needed to stock the job. Note that no money is shown 
on this report. 

 

Custom Reports  

User defined Crystal Reports can be created to fit individual customer needs.  Refer to the Custom Reports 
Supplement to learn how to create and store .rpt files in the Quick Bid Report Library. 

Call your On Center Software sales representative to explore this additional reporting feature. 
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Exporting Reports 
Quick Bid reports can be exported to other programs such as MS Word, MS Excel, Adobe Acrobat, etc. from 
the Bid Reports Preview dialog.   

1. Select a report in the Bid Reports dialog.    

2. Click the  button. The Bid Reports Preview dialog appears. 

3. Click the Export Report icon  in the upper left corner of the screen. The Export dialog appears. 

 

4. Select the format you want to export your report in from the Format field by clicking the drop down 
arrow for the list. 

5. Select the destination for your export from the Destination field by clicking the drop down arrow for 
the list.   

• Application - This selection will allow you to open the export file in the chosen format. You 
can then save or e-mail the file as needed.  

• Disk file - This selection will allow you to save the export file to a location on your 
computer's hard drive.  

• Exchange folder - This selection will allow you to save the export file to an exchange folder 
such as MS Outlook.  

• Lotus Domino - This selection allows the export file to be saved to a Lotus Domino server 
for saving or e-mailing.  

• Lotus Domino Mail - This selection allows the export file to be e-mailed directly vial Lotus 
Domino E-mail.  

• MAPI - This selection will allow you to send the export directly via e-mail to most mail 
recipients regardless of the type of e-mail application being used.   
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6. Click .  The Choose export file dialog will appear. 

7. Choose which pages of the report you want to export, then click . The Choose export 
file dialog appears. 

 

8. Browse to the location to which you want to save the export and click . The export is 
now saved in this location in the file format you chose. 

 

Exporting Bid Information  
Quick Bid allows you to export bid information without having it in a report.  It exports the information into 
an Excel Spreadsheet.  This is recommended when using data for an accounting software.  The setup for 
Exports is similar to the setup for generating the reports. Only certain reports information is available for 
export.  See the Bid Export dialog below for a list.  

1. Click on the bid and then click the Exports button  or 

From the Main menu, Bid > Generate Exports.  The Bid Exports dialog appears. 
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2. Click on the report you want to export, and click its Options button. The Modify Options for dialog 
appears. 

 

3. Browse to the location you want to export the file to by using the Lookup button, and click 

. The file will appear in your location as a .CSV (Excel) file. 
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Proposals 
With Quick Bid, you are able to generate bid proposals with all the information you need. The proposals are 
generated using MS Word .dot (template) files.  There are three templates to choose from, and you can use 
them at any time. You can also edit a template, and save it under another name to fit your specific needs.  
Quick Bid will auto populate the necessary fields with information from the program.  

NOTE: For Quick Bid to see your templates, they must be saved in the Template subdirectory of the 
Database Folder. This should be located at C:\OCS Documents\Quick Bid\Templates, by default). In 
addition, when editing a template, makes sure you spell the names of the fields correctly.  If a field name is 
misspelled, Quick Bid will not recognize the field and it will not auto populate. 

 

Generating Proposals 

1. Click on the bid in the Bid Navigator. 

 

2. Next, click the Proposals button  or  

From the Main menu, Bid > Generate Proposals. The Generate Proposals dialog appears. 
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3. Click once on the proposal template you want to use. DO NOT DOUBLE CLICK. 

4. Enter a contact or click the Lookup icon  to select from a list. 

5. Click  to add a contact if needed. 

6. Once you have added your contacts, click  to generate the proposal. The proposal will 
open in your default word processing program, MS Word for example. Once it opens, print the 
proposal from that program, or save it on your computer or network and e-mail it. 

NOTE: If you select multiple contacts, Quick Bid will generate a separate proposal for each. 
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Editing Proposal Templates 

Proposal templates may be modified at any time. You can add and delete information, copy and paste fields 
from one location to another, change the layout or look of the template, and modify the template in any way 
that you need. 

1. Click the Proposals button  or  

From the Bid menu, click Generate Proposals. The Generate Proposals dialog appears. 

 

2. Double-click on a template in the Select a Template field. MS Word will open the template filed. 

3. Modify the template as needed. 

4. When you have made all the needed changes to the template, from the File menu, click Save As. 
The Save As dialog appears. 

5. Enter a name for you template and make sure that it is being saved in C:\OCS Documents\Quick 
Bid\Templates.  NOTE:  Always rename your modified template so that you always have the 
original template as a backup. 

6. The new template will appear along with the original templates in the list. 

NOTE:  Each field on a proposal template pulls information from a bid.  For a detailed description of the 
fields, see About Proposal Template Fields in Program Help.  
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eQuotes 
In partnership with Gypsum TodaySM, a leading source for information in the North American construction 
industry, the eQuote feature compiles the information on the Materials tab and creates a material quote 
request that is sent to participating suppliers to view and bid.  

Register online at www.gypsumtoday.com to establish this time saving service. 

NOTE: You will be given a URL Address, User ID and Partner ID from Gypsum Today.  These will need to 
be stored in Quick Bid to activate this feature.    

 

Settings eQuotes 

1. From the Main menu, select Tools > eQuote Settings....  The eQuote Settings dialog appears. 

 

2. Enter the Address, User ID and Partner ID you received from Gypsum. 

3. Click .  The eQuote button  will now display on the Bid toolbar, and the 
Send eQuote Request option will be available from the Bid menu.  

 

Sending eQuotes 

The eQuote includes the Bid Number, Job Name,  Job Site Name and Address, and all the information from 
the Materials tab.  This information is required to assemble your quote package.  eQuotes can be sent from 
the original bid, an alternate or a change order. 

NOTE:  Make sure to have all required information up-to-date and stored in Quick Bid.  The program will 
not allow the quote to send without this information. If information is incomplete, an error message will be 
triggered letting you know what is missing.  
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1. From Main menu select Bid > Send eQuote Request, or 

Click on the Bid toolbar.  

2. From the Send eQuote Request dialog, click .   

 

• The Status area will show the progression of the sending process. A confirmation message will 
be displayed in the Status area when the process is complete. 

• The eQuote Information area lists the information contained in the quote. Verify the 
information is correct before sending. 

• The button can either cancel the process before it starts or during the process. 

3. Once the process is complete, click to exit the dialog. 
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Quick Bid and On-Screen Takeoff Interaction Rules 
• On-Screen Takeoff must be version 3.3 or higher to use the interactive bid feature.    

• The bids in On-Screen Takeoff and Quick Bid must have the same number of conditions and the 
same condition numbers to be connected.  Conditions link by number and name. 

• Create new bids in On-Screen Takeoff.  

• Create new and delete old conditions on the On-Screen Takeoff Condition Properties dialog. 

• Update condition quantities in On-Screen Takeoff.  OST dictates to QB.   

• Add or adjust labor, material, and other costs on the Quick Bid Condition Details dialog. The On-
Screen Takeoff Labor Codes tab is locked in interactive mode. 

• To open the Quick Bid Conditions Detail dialog from On-Screen Takeoff, right-click the condition 
and select Change Details. 

 

Interactive Bids 
Enable communication between Quick Bid and On-Screen Takeoff. 

1. Go to the bid Cover Sheet in On-Screen Takeoff  

2. Select either Price Using Quick Bid (interactive) or Price Using Quick Bid (manual). You must select 
one of these two methods to link the programs. 

NOTE: With Price Using Quick Bid (interactive) your bid updates automatically in real-time. With 
Price Using Quick Bid (manual) the user initiates the update (see below for instructions). 

Price Using Quick Bid (interactive) 

• With this method information is automatically updated between the programs. 

• This is the preferred method of interaction as it ensures that changes in one program are 
automatically updated in the other. 

Price Using Quick Bid (manual) 

• With this method you must initiate the updating of information between the programs. This can 
be done in either program. 
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Updating a Bid from On-Screen Takeoff 
Update or refresh data between the programs in On-Screen Takeoff. 

1. Go to On-Screen Takeoff.  

2. Select the bid you want to update, and press F9 or  

From the Main menu, Bid > Refresh Quick Bid. 

 

Connecting and Disconnecting Bids 
1. To disconnect a bid from within Quick Bid, go to the Bids tab and right-click on the bid and select 

Disconnect from On-Screen Takeoff Bid, or 

Select the bid and click Bids > Disconnect from On-Screen Takeoff Bid on the main menu bar. 

2. To reconnect a bid to Quick Bid, select the bid on the On-Screen Takeoff Bids tab. 

3. Go to the Quick Bid Bids tab and select the bid you want to reconnect to On-Screen Takeoff. 

4. Right-click the selected bid in Quick Bid and select Connect to On-Screen Takeoff Bid or 

5. Select the bid and click Bids > Connect to On-Screen Takeoff Bid on the main menu bar. 

6. Enter the On-Screen Takeoff bid number in the dialog box that comes up and click . 

Note: When reconnect to existing bids, open the bid in On-Screen Takeoff and reconnect from Quick 
Bid. 

 

Creating and Updating Bids Using *.ost File   
Create  

1. To create a bid from On-Screen Takeoff, from the File menu, click New > Bid from On-Screen 
Takeoff, or  

Click the New icon  and click Bid from On-Screen Takeoff, or  

Right-click anywhere in the Bids window and select New > Bid from On-Screen Takeoff.  The 
Create bid from On-Screen Takeoff dialog appears. 
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2. Choose the Access Method in which you want to retrieve your takeoff.   

• Only OST v.2.x users can select Access current On-Screen Takeoff project with OST open to the 
current project. 

• All OST users can select to Load On-Screen Takeoff project from file.  Either type the file path, or 
click the Browse button to locate it. 

3. (Optional) Place a check in the Import zero-quantity conditions box. If checked, any conditions in 
On-Screen Takeoff that do not have any quantity in them, will still appear in Quick Bid. 

4. (Optional) Place a check in the Create bid areas for unused areas box. If checked, any areas in On-
Screen Takeoff that do not have takeoff quantities will still appear in Quick Bid. 

5. (Optional) Select a number that Quick Bid will Round decimal places to. Your On-Screen Takeoff 
project may show condition quantities with up to 4 decimal places.  If you choose, you can change 
the number of decimal places that Quick Bid will accept.  Quick Bid can also show all 4 decimal 
places or just one whole round number by selecting decimal places. Your conditions quantities are 
displayed at the Conditions tab in Quick Bid. 

Update 

1. From the Main menu, Bid > Update from On-Screen Takeoff.  The Update bid from On-Screen 
Takeoff dialog appears. 

 

6. Choose your Access Method and Options, then click . 
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